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1. Intro

Thank you for purchasing “Train Controller (Railroad System)”!

This package contains all that you need to build a simple and functional railroad (models,
scripts and SFX).

More models may be included in the future and/or sold separately as extensions (Addons
Available).

It's really simple to use and customize.

1.1. What is new on v3.4?

Up to v3.3, the asset was mainly focused on Physics Based Trains. Starting with v3.4, Spline
Based Trains will also be supported.

But why is the inclusion of spline based trains such a big deal?

Well, physics based trains are fun, but are not suitable for all types of projects. For instance,
must AAA open world games don’t rely on physics based trains, to name a few recent
examples: Assassin’s Creed Syndicate, Red Dead Redemption 2 and the infamous
unstoppable GTA V train, all of which were developed using non-physics trains solutions.

But why do AAA games avoid using physics based trains?

The answer is simple, in the current state of technology there is no perfect physics
simulation solution for games. Even AAA games are susceptible to random and
unpredictable physics glitches caused by the physics engine miscalculations.

Since trains are complex game objects by nature, if the main focus of the game is not
accurate train simulation, using a non-physics train solution may be a viable solution to
ensure stable and predictable train movement.

By including spline based trains support, the asset will now be useful for a broader range of
projects, making it a better train solution for everyone.

1.2. Update Guidelines v3.4

If you haven'’t installed any previous versions of this package on your project, or have
completely removed any previous versions, then you don’t need to worry about this section.

But, if you have already installed any previous versions on your project and downloaded
version 3.4 as an update inside the Unity Editor. Then, you may need to check your custom
prefabs, since the Unity Editor will not update custom prefabs automatically.

For custom Train prefabs created on previous versions, it's recommended to replace the
locomotive and all wagons to make sure the new changes will apply correctly.


https://assetstore.unity.com/lists/train-controller-104802
https://assetstore.unity.com/lists/train-controller-104802

If you have downloaded any Additional Wagons, don’t forget to download the corresponding
updated version of those wagons before replacing them on your custom train prefabs.

You can also use the new Custom Wagons Creator to rebuild your own custom locomotive
and wagons prefabs. This will ensure that the custom wagons and locomotives are set up
correctly.

For any railroad builder created before the update, may also need minor adjustments
(selecting mesh generation profile and regenerating rails (1 click process)).

v .« [« Spline Mesh Renderer (Script) [ = %,

MESH GENERATION SETTINGS
Spline RailroadBuilder_2Z00mGap (Spline) @
lo]

Mesh Generation Profile I ﬁRaiIruad Builder P‘hxsics Based !SMR I

Mesh Generation Method | Manual ¢ |
Mesh Offset X0 Y0 Z|0

Baked rails segments need to be regenerated due to the new features regarding spline
backup, railroad builder LOD support and the new BakedSegment component that is used to
easily connect baked segments in the editor.

Custom railroad turnouts will also need to be regenerated to support spline based trains.
For custom baked railroads and/or rail segments created on versions previous to v3.3, you

need to apply the “GuideColliderPhysicMaterial” to your custom rails “GuideCollider” child
object manually.

v pemo = @ Inspector B2 Mavigation B =
TopCamera
EventSystem vy ¥ GuideCollider [[] static =
» Directional Light Tag | Untagged 4| Layer | Default ™
DemoController Prefab | Select | Revert | Apply |
P Canvas
Terrain ¥~ - Transform £,
» ControlZones Position ®o
P RailroadBuilder_Elevation Rotation ]
B Train_Sample_1 Scale X1
VRa\Irgadl_Prefab ¥ |::f @ Mesh Collider @
RailsCollider
Convex -

GuideCollider

Create ™

Inflate Mesh

Skin Width
Is Trigger

0.01

Material I «£ GuideColliderPhysicMaterial

Mesh

WRailroadl_guideCollider_mesh

» &3 Train Controller_vZ 2

¥ &3 Train Controller_v2

» &3 Addons

% Demo

ﬁ Documentation
» &3 Prefabs
» &3 Railroad Builder
» &5 Scripts
¥ & Shared

&5 Animation
» &3 Models

Assets » WSM Game Studio » Train Controller_v3 » Shared » Physics

¥}

GuidecColl..


https://assetstore.unity.com/lists/train-controller-104802

2. How to Use This Asset

In this section you will learn how this asset works and how to use it based on the sample
prefabs.

2.1. Quick Start Guide

This asset supports both physics based and spline based trains. Regardless of which
approach you decide on using on your game, the overall workflow is almost the same.

Choose between physics based or spline based trains

Use the Railroad Builder to create railroads on your scene

Use the Route Manager to define the routes on your scene

Use the Train Spawner to spawn locomotives, wagons and trains
Customize

Customization tools are also available to make it easier to customize your project. For more
information, take a look at Custom Wagon Creator, Custom Turnout Creator and Rail
Generation Profiles sections.

2.2. Physics Based Trains

Up to v3.3, this asset was mainly focused on physics based train movement. Physics
based trains works by using guide colliders to keep the train on rails, while applying forces to
simulate acceleration, brakes and wagon connections.

v €] RailSwitchingAlwaysDemo -=
_ EventSystem
b . /Canvas
b Cameras
¥ . Enviroment
.. Plane
.. Directional Light
b i DirectionIndicator_01 (1) >
b by DirectionIndicator_01 (2) >
b | RailroadGenerators 2
¥ | RailroadPrefabs -
» b RailSwitch_100mx20m_Paraly "E'q_._._._‘,
b b RailSwitch_100mx20m_Pats . | .
¥ byl Railroad_z00mGap_prefabi(
_/Mesh_LOD0O
_/Mesh_LOD1
./Mesh_LOD2

—
i Collider_2 -
./ EndPoint
_/Railroad_200mGap_Splin
P by Railroad_200mGap_prefab?(
.  ControlZenes
P by Train_Long >

"o

The rails are composed of base colliders and guide colliders that compose the path that the
train will follow.

The TrainController component attached to the locomotive controls acceleration, brakes,
SFX, doors, lights and wagons.

The wagons are connected by Joints and inherit locomotive movement and commands while
connected.



2.3. Spline Based Trains

Spline based trains are a non-physics train solution that works by using a spline following

algorithm to follow a predetermined route.

Note: Spline based trains reuse the same splines used by the Railroad Builder to
generate the rails. However, unlike physics based trains, spline based trains don't need
rail colliders to stay on track. For more information about rails generation, please take a
look at the Railroad Builder section.

A route is composed of one or more splines assigned to the Spline Based Locomotive
component, as shown in the sample image below.

¥ = [« Spline Based Locomotive (Script)

@ 3 %

Controls Wagons

Lights VEX/SFX Other Settings |

TRAIN CONTROLS
Engines On

Max Speed
Acceleration
Automatic Brakes
Brake

| Acceleration Rate

SPLINE SETTINGS

o)
(=]

300 |kph 3]

Q) |1

15

W Route Splines
Size
Element 0
Element 1
Element 2

3
Railroad_1_Spline (Spline) @
Switch_1_5Spline_1 (Spline) @
Switch_2_Spline_1 (Spline) @

Follower Behaviour | Loop

Custom Start Position

Visualize Route On Editor 4
TRAIN OPERATIONS

[ Stop Engine

Cpen Left Cabin Doar
Open Left Passenger Door
SPLINE OPERATIONS

Cpen Right Cabin Door

Open Right Passenger Door

Restart Follower

[ Move to Start Position H

H Recalculate Offset

Routes can be manually assigned to any locomotive by dragging and dropping splines on
your scene to the Route Splines property of any locomotive, however, it is highly
recommended to use Route Manager to create, edit and assign routes to trains.

not assigned, the train will not be able to move.

Note: Spline based trains need splines to move, therefore, if the Route Spline property is

When “Visualize Route on Editor” is enabled, it is possible to visualize the current route

assigned to the selected locomotive.


https://en.wikipedia.org/wiki/Spline_(mathematics)

The Spline Based Locomotive component attached to the locomotive controls acceleration,
brakes, SFX, doors, lights and wagons.

The wagons are connected using a linked spline following algorithm and inherit locomotive
movement and commands while connected.

2.4. Physics Based X Spline Based Trains

Physics based and spline based train movement are two distinct approaches used to
simulate train movement on games, both of which have its pros and cons:

e Physics Based Trains Pros
o Wheels follows the rails curvature
o Couplers stay connected to each other on curves
o Can simulate derailment (if you need to)
o Simulates train shaking based on speed
o Turnouts are easier to set up
e Physics Based Trains Cons
o May derail at high speeds on sharp curves
Maximum speed limit (105kph)
Performance heavy for mobile games
Hunting oscillation at higher speeds
Susceptible to Unity physics engine glitches
Wagons will not follow railroad curves when spawning a train

O O O O O

e Spline Based Trains Pros
o Never derails
o No speed limit
o Performance friendly for mobile games
o Smooth movement at higher speeds (No Hunting Oscillation)
o Wagons follows railroad curves when spawning a train
e Spline Based Trains Cons
o Wheels doesn’t follows the rails curvature
o Couplers don’t stay connected to each other on curves
o Turnouts relies on Route Manager to change route

Note: Which approach is ideal for your game, depends on your project's needs.
Therefore, before starting your project, analyse the pros and cons and select which one is
more suitable for you.




2.5. Recommended Layers for Physics Based Trains (Optional)

The package is ready to use as it is. Although, to avoid unwanted collisions with the rails
guide colliders when using physics based trains, it is recommended to customize the Unity
Collision Matrix.

Go to “Edit > Project Settings > Tags and Layers”, add new layers for the rail guides and
train wheels (Ex: RailGuide and TrainWheels). Change the layers of the train wheels and rail
guides of the prefabs.

Go to “Edit > Project Settings > Physics” and change the collision matrix so the “RailGuide”
layer will collide only with the “TrainWheels” layer.

g -
7 o 8
o @ m
S =%
S0 =2ada
mC, oo 3y
TEc@afdc
Default(v [ |1« [V ¥ ¥ [+
TransparentFx (v [ | [+ [« [« [+
Ignore Raycastls [ |+ [ [+
Water [« | [+ [+
UL ]I
RailGuide [« |

TrainWheels [+

For more info about the collision matrix, check the |ayer-based collision official
documentation.

2.6. Sample Prefabs

This package includes a ready to use railroads and train sample prefabs. These prefabs can
be seen in action at the demo scenes included in the project.

If you wish to use these prefabs on your game, all you need to do is drag and drop a railroad
and a train to your scene. You can also customize speed and acceleration in the
TrainController or Spline Based Locomotive component attached to the locomotive.

v = [« Train Controller_w 3 (Script) Q=
Wagons | Lights | VFX/SFX | Other Settings ]

TRAIN CONTROLS
Engines On o
Max Speed 65 Kph &
Acceleration O |1
Automatic Brakes o
Brake O 0
Acceleration Rate 5



https://docs.unity3d.com/Manual/LayerBasedCollision.html

v = ¥ Spline Based Locomotive (Script) (X

Wagons | Lights VFX/SFX | Other Settings ]

TRAIN CONTROLS

Engines On "4

Max Speed 65 Kph &
Acceleration O |1
Automatic Brakes 4

Brake O i}
Acceleration Rate 15

Note: By default, the sample prefabs are configured as automated trains, if you wish to
manually control your train, take a look at the player input section.

2.7. Locomotive & Wagons Prefabs

A train is composed of a locomotive and wagons. There are six locomotive variations and a
set of wagons prefabs at the “Prefabs” folder.

More locomotives and wagons may be included in this package in the future and/or sold
separately as extensions (Addons Available Here)

See the Building a Train section for more info on how to use these prefabs.

Assets > WSM Game Studio » Train Centroller_v3 > Prefabs »

Caontral 2.  Deprecat.. Misc Sample T.. Sinalizati.. Turnouts Locomoti. Locometi.. Locomoti. Locomoeti. Locomoti.. Locomaoti.

Flatform... Flatfarm... Flatform... Platform... Flatfarm... Platform... Flatform... Flatform.. READ ME.. s_lLocomo.. s_Locomo.. s_Locomao..
s_Locome.. s_Locemo. s_Locomo.. s_Platfor. s_Platfor.. s_Platfor.. s_Platfor. s_Platfor.. s_Platfor. s_Platfor.. s_Platfor..

Note: Spline based locomotives, wagons and sample prefabs were named using the “s_"
prefix for easier identification.

2.8. Legacy Prefabs (Deprecated)

Up to version v2.0, the railroads were composed of joined rail segments prefabs.

On the v3.0 update, those prefabs were replaced by the Railroad Builder, which is much
easier to use and gives much more control over the railroad building process.

However, the rail segments prefabs were kept at the “Deprecated > Rails Segments” folder
for those who bought any previous version of the package and wish to keep using them for
any reason.

10


https://assetstore.unity.com/lists/train-controller-104802

Assets » WSM Game Studio » Train Controller_v3 » Prefabs » Deprecated » Rails Segments

Rails_20m Rails_20.. Rails_40.. Rails_80.. Rails_10. Rails_16.. Rails_32.

The Railroad Builder is now the official method for building railroads. For more info on how to
use it, take a look at the Railroad Builder section.

On the v3.3 update, the default locomotive model was replaced by a more realistic model.

The old locomotive prefab can still be found inside the “Deprecated” folder.

Assets » WSM Game Studio » Train Controller_v3 » Prefabs » Deprecated

Rails Seq.. READ ME

Note: You can still use deprecated prefabs if you wish so, however, keep in mind that
deprecated content will not be updated or guaranteed to be compatible with future
versions.

11



3. Train Controls

In this section you will learn how to control and monitor your train speed.
You can either have fully automated trains moving around your scene or you can have a
player controlled train, either by keyboard input or Unity UI.

3.1. Automated Trains

To add an automatic train at your scene, all you need to do is to set up the train behavior by
adjusting the locomotive settings at the Unity Editor.

Note: You can also change train settings automatically at runtime by using Control Zones

The Train Controller component is responsible for controlling physics based locomotives.

¥ « o Train Controller_v 3 (Script)

= %,

Wagons |

Lights VFX/SFX | Other Settings I

TRAIN CONTROLS

Engines On

Max Speed

| kph 4

Acceleration
Automatic Brakes

O |1

[=]

Brake

Acceleration Rate

TRAIN OPERATIONS

I

Stop Engine J

Open Left Cabin Door

Open Left Passenger Door

Open Right Cabin Door

Open Right Passenger Door

The Spline Based Locomotive component is responsible for controlling spline based

locomotives.

¥ = [ Spline Based Locomotive (Script)

@ =

Wagons ]

Lights VFX/SFX Other Settings |

TRAIN CONTROLS

Engines On

Max Speed 65

Acceleration
Automatic Brakes

Brake

7 &

Acceleration Rate

SPLINE SETTINGS
M Route Splines

Fallower Behaviour

ar

| Laop

Custom Start Position Cr
Visualize Route On Editor o

TRAIN OPERATIONS

I

Stop Engine ]

Open Left Cabin Door
Open Left Passenger Door

SPLINE OPERATIONS

Cpen Right Cabin Door
Open Right Fassenger Door

[ Move to Start Position il

Restart Follower | Recalculate Offset |

12



The Engines On property is enabled by default, if you don’t want your train to start moving
automatically, you can disable it by unchecking it directly or using the button at the Train
Operations Section.

Note: Some operations are enabled only at runtime. For example, all door related
operations.

The train speed is controlled by the Max Speed Kph and Acceleration properties of the
Train Controller script.

The Max speed of physics based trains is a range between 0 kph and 105 kph (based on
real world trains average max speed values). Spline based trains max speed is not limited,
so if you need your train to move faster than 105kph, spline based trains are the way to go.

The acceleration property, defines train movement direction:

e Acceleration 1: Forward
e Acceleration 0: Stop
e Acceleration -1: Reverse

You can also use the Brake property to reduce train speed and stop the train. When the
Automatic Brakes property is enabled, the brakes are applied automatically when the
acceleration property is reduced.

You can switch your train lights on/off in the Unity Editor by using the buttons available at the
Light Operations section. By default, internal lights are on and external lights are off.

[ Controls | Wagons VEX/SFX | Other Settings

TRAIN LIGHTS

External Lights
Internal Lights

LIGHTS OPERATIONS
[ External Lights “ Internal Lights

3.1.1. Control Zones

Control Zones are used to control the train behaviour on the railroad at runtime. This is very
useful to automate your railroad.

These zones are simple colliders that trigger events once the train passes through them.

13



Assets » WSM Game Studio » Train Controller_v3 » Prefabs » Control Zones

vy

BellAactiva.. BellDeact. CustomE.. HeonkZone ReverseDi.. SpeedCh.. StationSt.. SwitchTri..

Bell Activation Zones: Activates the train bell

Bell Deactivation Zone: Deactivates the train bell

Honk Zone: Activates train horn

Reverse Direction Zone: Reverse train direction

Speed Change Zone: Changes train max speed value

Station Stop Zone: Automatic station stop (see Train Stations section)
Switch Trigger Zone: Switch rails direction (see Turnouts section)
Custom Event Zone: Trigger custom user events

Note: It is recommended to use Speed Change Zones to reduce train speed before
railroad curves and increase speed on straight segments. This will add more realism to
your scene and increase physics based trains stability on curves.

If none of the existing zones fits your project needs, you can use a Custom Event Zone to
trigger custom events on your scene. This opens infinite possibilities on what you can do in
your game.

‘F@ Custom Event Zone (Script) &,
Script CustomEventZone o]
Custom Ewvents ()
List is Empty
+

3.2. Player Input

There are two ways of controlling a train with player input: by using the Unity Ul or
customizable keyboard input.

The Unity Ul method basically works by overriding the automatic train settings and calling
locomotive public methods directly. Take a look at the first Demo scene for a sample on how
to control your train using the Unity Ul.

Assets » WSM Game Studio » Train Controller_v3 » Demo

mdL

Terrains DemoPla.. DemoSpe.. InGameW..

To get keyboard input, you need to enable the Train Player Input component on your
locomotive.

14



T@ [« Train Player Input (Script) L

Script TrainPlayerlnput @
Enable Player Input [
Input Settings L DefaultTrainInputSettings (TrainlnputSettir @

b Custom Ewvents

Note: For Unity Ul input, make sure the Enable Player Input property is disabled. This
property is intended to be used for keyboard input only.

This component is responsible to process player input and trigger train default and custom
events. The keys configuration is defined by the Input Settings and can be easily
customized. You can even have multiple trains, with distinct inputs being controlled at the
same time.

3.2.1. Custom Input Settings

The default input settings are located inside the Player Input folder.

Assets » WSM Game Studio » Train Controller_v3 = Player Input

DefaultTra..

Note: Train Input Settings are stored inside Scriptable Objects, which means, you can
create your own custom input settings either by duplicating the file or by using the Unity
Editor creation menu:

Right Click > Create > WSM Game Studio > Train Controller > Train Input Settings

In the image below, you can see the default key input settings. You also see this in action at
the DemoPlayerinput demo scene.

© Inspector |_“ MNavigation B =
DefaultTrainlnputSettings &
< [open
Script TrainInputSettings @
Togagle Engine | E |
Forward [ W |
Reverse L5 t |
Increase Speed | Page Up |
Decrease Speed | Page Dawn |
Speed Increase Amount E
Brakes | Space |
Lights L |
Internal Lights |1 |
Henlk | H al
Bell | B t |
Cabin Left Door | Alpha 1 4
Cabin Right Door | Alpha 2 ]
Fassenger Left Door | Alpha 3 ]
Passenger Right Door | Alpha 4 ]
¥ Custom Event Triggers
Size z
Element 0 | D i
Element 1 [A m

15
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3.2.2. Custom Events

Besides the default train input, you can also create custom events triggered by player input.
The key mapping for these events must be added on the Custom Event Triggers property
of your train input settings file.

¥ Custom Event Triggers

Size (2 |
Element 0 | D |
Element 1 [ A |

The corresponding events must be included at the Custom Events property of the Train
Player Input component attached to your locomotive.

‘F [ Train Player Input (Script) [z %,
Script TrainPlayerlnput o]
Enable Player Input [+
Input Settings EDefaultTrainInputSettings {TrainInputSettings| @

W Custormn Events

Size [2 |
Element 0 ()

aF

Runtime Cnly # || TrainContraller_w3.DecoupleFirstWagon

Element 1 ()

E
_|
=
E
=]
[
(=]
=
t
2]
(=]
w
=

|
-
[
(W)
m
m
o
(=

=
1
-
w
i
t
=
w

(=]
o
=
ET3

Runtime Cnly %

| anumutive_ﬂl_ﬂl

Note: You can have as many custom events as you wish. Just make sure to fill the
Custom Event Triggers on your input setting file and the Custom Events property of the
Train Player Input component attached to your locomotive.

3.3. Train Speed Monitor

You can monitor train current speed, by using the Train Speed Monitor attached to the
locomotive prefab.

¥ = ¥ Train Speed Monitor (Script) @ = #*
Script TrainSpeedMonitor (o]
Output Text | SpeedText (1) (Text) @

You can print the current speed value to a Text field, just Drag & Drop your text to the
“Output Text” property. The speed unit can be selected at the locomotive component, next to
the Max Speed property.

16



TRAIN CONTROLS

Engines On o

Max Speed |65 [kph__#]
Acceleration v Kph
flutf:matlc Brakes _ﬁ Mph

In all the Demo scenes included in the project, the speed is printed to the SpeedText label,
as you can see below.

v QTrainStationDemo

17



4. Building a Train

In this section you will learn how to build your custom train using the locomotive and wagons
prefabs.

4.1. Connecting Wagons (Editor)

Additional wagons were used in this sample (Available Here)

To start building your train, drag and drop the locomotive prefab on your scene.

Note: Alternatively, you can also use the Spawn Railway Vehicle operation of the Train
Spawner to spawn the locomotive on top of the rails.

Assets » WSM Game Studio » Train Controller_v3 » Prefabs »

Contral Z... Deprecat.. Misc Samples Sinalizati... Turnouts Locomoti... Locomoti... Locomoti... Locomoti... L:::m:tl Locomoti... Platfarm...

Drag & Drop wagons prefabs on your scene. Then, select the wagons on your scene and
drag & drop them on the “Wagons” property of the locomotive in your scene.

» Rai|,-nadaﬁﬁde‘-(cmne) ¥ |G| # Train Controller_v 3 (Script) [FE2
Directional Light Wagons Lights | SFX | Other Settings ]
HonkZone
S TRAIN WAGONS

P Canvas Y Wagons

P RailroadBuilder Size 9
Plane Element 0 - CargoWagon01_Blue (Wagon_v3) @
EventSystem Element 1 - CargoWagon01_Gray (Wagon_v3) @

¥ RailroadBuilder (1) ) Element 2 CargoWagon01_Orange (Wagon_v3) @

:Ié‘;i‘;:];t;‘;n%ll ‘:ITEE Element 3 © CargoWagon02_Brown_Gravel (Wagon ©

» CarguWagnnm:Gray Element 4 i~ CargoWagon02_Blue (Wagon_v3) @

» CargoWagonOl_Orange Element 5 CargoWagon02_Orange_Stones (Wago ©

» CargoWagon02_Brown_Grav Element 6 - CargoWagon03_Blue (Wagon_v3) <]

» CargoWagon02_Blue Element 7 - CargoWagon03_Green (Wagon_v3) [}

P CargoWagon02_Orange_Ston +, W ] Element 8 i CargoWagon03_0Orange (Wagon_v3) @

| e L Vi ' WAGONS OPERATIONS

# CargoWagon03_Green

W CargoWagon03_Orange | Connect Wagons |

Decouple First Wagon Decouple Last Wagon

18
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Note: For physics based locomotives the wagons property is located under the wagons
tab of the TrainController component. For spline based locomotives, the wagons property
is located under the Wagons tab of the Spline Based Locomotive component.

For physics based locomotives, click the Connect Wagons button at the Wagon
Operations section and the wagons will be repositioned automatically behind the
locomotive, following the wagons list order.

"@ ¥ Train Controller_w 3 (Script) ﬁ *
[ comor  [NIETTRN ot [Sther setings]
TRAIN WAGONS

Wagons

Size

Element 0 CargoWagon01_Blue (Wagon_v3)
Element 1 CargoWagon01_Gray (Wagon_w3)

Element 2 CargoWagon01_Orange (Wagon_w3)
Element 3 CargoWagon02_Brown_Gravel (Wagon
Element 4 CargoWagon02_Blue (Wagon_v3)
Element 5 CargoWagon02_Orange_Stones (Wagao
Element 6 CargoWagon03_Blue (Wagon_v3)
Element 7 CargoWagon03_Green (Wagon_v3)
Element 8 CargoWagon03_0Orange (Wagon_w3)

WAGONS OPERATIONS

O Q60006000

Connect Wagons

Decouple First Wagon Decouple Last Wagan

Note: Physics based wagons will connect on a straight line behind the locomotive and will
not follow railroad curves. Physics based trains use colliders to follow railroad curves and
currently it is not possible to calculate the precise position of the wheel trucks for the
wagons on curved railroad sections.

If you're using physics based trains on your project, make sure your locomotive is
positioned on a straight rail section before connecting the wagons.

Spline based wagons are not affected by this limitation and will follow railroad curves
when connecting.

For spline based locomotives, you can click either the Connect Wagons or Move to Start
Position button at the Spline Operations section and the wagons will be repositioned
automatically behind the locomotive.
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¥ « [« Spline Based Locomotive (Script) @ = %

Wagons Lights | WER/SFX | Other Settings ]

TRAIN WAGONS

First Wagon Offset 11.9
Wagons Behaviour | Wrap 0
Wagons

SPLIME OPERATIONS

I Mowve to Start Position I[ Restart Follower “ Recalculate Offset ]

WAGONS OPERATIONS

| Connect Wagons I
Decouple First Wagon Decouple Last Wagon

Note: the Route Splines property of your spline based locomotive must be assigned in
order for the wagons to connect properly. Also, the “Move to Start Position” operation will
also move the locomotive to the current selected route, before repositioning the wagons.

4.2. Connecting Wagons (In-Game)

By default, in-game coupling is enabled for all wagons prefabs. You can check the couple
settings under the Coupling tab in the Wagon component attached to each wagon prefab.

‘l’@ ¥ wagon_w 3 (Script) ﬁ o,
Coupling Lights | SFx | Other Settings ]

COUPLIMNG SETTINGS

Coupling | Enabled ¢ |
Cecoupling Settings | Allow Recoupling ¢ |
Recoupling Timeout 5

Here, you can enable and disable wagon coupling and configure if this wagon should be
allowed to be re-coupled after being decoupled from the train for the first time

To couple a wagon to your train in-game, all you need to do is use the reverse gear and
slowly approach the wagon until you hear the connection SFX feedback.
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After connecting, the couplers should look like this:

- (e

You can connect as many wagons as you wish to your train. Everytime couplers collide, they
will connect, provided the coupling is enabled for that wagon.

Note: Physics based trains couplers are universal, so they can be connected from either
side. You can also use the locomotive front coupler to connect to a wagon if you wish so.

You can also decouple wagons from your train in-game. You can either decouple the first,
the last or any other wagon.

While in the Unity Editor, you can test wagon decoupling using the buttons on the Wagons
Operations section.

T |/ Train Controller_wv 3 (Script) £,
Wagons Lights SFx Other Settings ]

TRAINM WAGONS

W Wagons

Size 1

Element 0 - CargoWagon0l_Blue (Wagon_v3) @

WAGONS OPERATIONS

[ Connect Wagons [

|_ Decouple First Wagon | Decouple Last Wagon I

If you have a train controlled by player input, using the default input settings, you can use D
and A keys to decouple the first and last wagons respectively.

Note: The decoupling methods are configured on the Custom Events at the Train Player
Input component. This is a sample on what can be done by using custom events.

You can also call the decoupling methods directly if you wish so. They are public methods
located at the locomotive script (TrainController script for physics based trains and
SplineBasedLomotive script for spline based trains).
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e DecoupleLastWagon()
e DecoupleFirstWagon()
e DecoupleWagon(int index)

Note: When decoupling wagons by index, keep in mind that the first wagon is equivalent
to index 0, following the .NET collections index logic.

After decoupling a wagon, if recoupling is enabled, you need to move away to separate the
couplers before the recoupling timeout is elapsed (in seconds), or it will recouple the

wagon again automatically.
%

I

T ¥ Wagon_v 3 (Script)
Lights SFX Other Settings

COUPLING SETTINGS
Coupling | Enabled

Decoupling Settings | Allow Recoupling
Recoupling Timeaout 5 I

ECAN BT

If you don’'t want to recouple again for any reasons, you should change the Decoupling

Settings to Never Recouple.

COUPLING SETTINGS
J

Coupling | Enabled P
Decoupling Settings | Allaw Recoupling $ |
Recoupling Timeaut v Allow Recoupling
i SMR_Ignored Object (Sc Mewver Recouple g #
- =l e

= — _ — _
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5. Custom Wagon Creator

Wagons and locomotives are complex prefabs, made specifically to be compatible with the
rails generated by the Railroad Builder. Due to this complexity, it can be tricky to manually
customize prefabs and ensure they will work properly.

The custom wagon creator was introduced to increase client customization options. It can be
used to create multiple custom wagons and locomotives, based on reusable user
customizable profiles.

For example, let's assume you have a collection of wagon models you wish to use on your
game. By using the custom wagon creator, you can quickly generate multiple customized
wagons with your models.

The Custom Wagon Creator is located in the Unity Editor, under Window > WSM Game
Studio > Custom Wagons Creator menu. Alternatively, it can also be located under WSM
Game Studio > Train Controller > Utilities > Custom Wagons Creator.

*
Custom Wagon | U,E
Custom Wagons Creator
Profile | MNone (Custom Wagon Profile) | ©
Model WMone (Game Object) o

Name

[ Create J

To create you custom wagon, first select the desired profile:

K"Q |
Assets
None

o Default Locometive Profile
< Default Wagon Profile

Then, select your custom model:

L=
2, platform

Assets
None

® PlatformwWagen_13_4
U PlatformWagon_13_4_Collider
i PlatformWagon_Black_13_4

Select a name for the object and click on “Create”
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B
Custorn Wagon | =

Custom Wagons Creator

Profile L Default Wagon Profile (CustomWagonProfile) o]
Model APlatformWagon_13_4 o
Mame [NewSampleWagor| |
I Create I

The custom wagon will be created on your scene.

v & Marketing
EventSystem
- Cameras
ETT e Custom Wagons Creator
b AllPrefabs
W ControlZones
NewSampleWagon

Custom Wagon

Profile L Default Wagon Profile (CustomWagonProfile)

Model WPlatformWagon_13_4
Name

NewSampleWagon

| Create

Wagon created successfully!

Verify if the wagon is working properly, then drag & drop it to your preferred folder to save it
as a prefab.

Note: You can also create custom locomotives. The type of object being created is
defined on the selected profile (See the Custom Profiles section for more details)

5.1. Custom Profiles

Custom Wagons Profiles defines the type and settings of the created object.

You can think of a profile like a blueprint that defines all the essential components that needs
to be included in the prefab to ensure it will work properly.

Profiles can be used for mass creation of custom locomotives or wagons prefabs. For
example, if multiple wagons models shares the same configuration, like length, wheel

positions, etc... You can use the same custom wagon profile to turn them into ready to use
wagon prefabs.

Assets » WSM Game Studio » Train Controller_v3 » Wagons Creator » _Profiles

Default L. DefaultL. DefaultW.. DefaultW..
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There are four sample profiles included in this package, for creating physics based and

spline based wagons and locomotives.

creation menu:

Note: Custom Wagons Profiles are Scriptable Objects, which means, you can create your
own custom profiles either by duplicating the existing files or by using the Unity Editor

Right Click > Create > WSM Game Studio > Train Controller > Custom Wagon Profile

Default Locomotive Profile (Physics Based) @ = % E Default Wagon Profile (Spline Based) @ = 2
| Open | | open |

Script CustomWagonProfile @ Script CustomWagonProfile @

Type | Locomative +#| Type | Wagan |

Train Type | Physics Based ¢|| Train Type | Spline Based Al

Speed Units | kph +|| Speed Units | Kph a

Input Settings Ll DefaultTrainInputSettings (TrainlnputSettings) @ Input Settings Mone (Train Input Settings) @

Model Offset X0 Y0 zZo Model Offset X0 Y1

Contrel Zone Trigger Position w0 ¥|1.57 Z|11.15 Control Zone Trigger Position *|0 Y0

Rails Offset X0 Y |0.14 zZo Rails Offset X0 Y 0.14

b Wheels Physics

b Wheels Visuals

b Steam Locomotive Rear Wheels And Pistons
¥ Front Coupler

b Back Coupler

» Default Joint Anchor

» Bumper

b External Lights

b Internal Lights

¥ Rail Sensor

b Passenger Sensor

b Suspension Collider

b Colliders

» Cabin Door Left

B Cabin Door Right

# Passenger Door Left

b Passenger Door Right

P Wheels SFX

- Wagon Connection SFX
P Engine SFX

P Brakes SFX

¥ Horn SFX

P Bell SFX

b Open Cabin Door SFX

» Close Cabin Door SFX

b Open Passenger Door SFX
b Close Passenger Door SFX
b Close Door Warning SFX
¥ Smoke Particles

b Braking Sparks Particles
b Internal Details

> Bell

As can be seen in the sample image above,

- Wheels Physics

» Wheels Visuals

- Steamn Locomotive Rear Wheels And Pistons
¥ Front Coupler

b Back Coupler

b Default Joint Ancher

» Bumper

b External Lights

b Internal Lights

I Rail Sensor

I Passenger Sensor

b Suspension Collider

b Colliders

I Cabin Door Left

I Cabin Door Right

b Passenger Door Left

b Passenger Door Right

P Wheels SFX

# Wagon Ceonnection SFX
P Engine SFX

P Brakes SFX

F Horn SFX

b Bell SFX

b Open Cabin Door SFX

¥ Close Cabin Door SFX

b Open Passenger Door SFX
b Close Passenger Door SFX
b Close Door Warning SFX
» Smoke Particles

b Braking Sparks Particles
I Internal Details

b Bell

profiles are very complex Scriptable Objects

that contain references to all the Parts that will compose your custom wagon. It also defines
which type of object will be created (locomotive or wagon).

For example, the Wheels Physics section, holds a reference to the prefab responsible for
simulating train wheels physics, and the Positions array defines how many and where the

instances should be spawned.

¥ Wheels Physics

Prefab

# WheelsTruck_physics

Custom Mame

¥ Positions
Size 2

¥ Element 0
Pasition X0 N Z\B.6
Rotation X0 N Z0

¥ Element 1
Pasition X0 N Z -8.6
Rotation ®\0 b Z 0
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The Wheels Visuals section, holds a reference to the prefab responsible for simulating the
wheels turning animation, how many and where the instances should be spawned.

¥ Wheels Visuals
Prefab i WheelsTruck_visual @
Custom Mame

¥ Positions
Size 4

¥ Element 0
Pasition X0 Yl Z\8.6
Rotation X0 Y0 Z0

¥ Element 1
Pasition X|0 ¥l Z 5.6
Rotation X|0 Y0 Z|0

¥ Element 2
Pasition X0 ¥l Z -5.6
Rotation X0 Y0 Z0

¥ Element 3
Position X|0 Tl Z|-8.6
Rotation X0 Y0 Z0

Note: As you can see in the sample image below, there are four visual wheels, but only
two physics wheels on the physics based locomotive profile. That's because there is no
need for more than two physics wheels to keep the locomotive on track, even though the
locomotive has four sets of wheels.

5.2. Wagons/locomotive Parts

Parts are the essential components needed to create working locomotives and wagons. The
default parts prefabs are stored inside the Wagons Creator > Parts folder.

Assets » WSM Game Studio » Train Controller_v3 » Wagons Creator = Parts »

Bumpars Collidars Couplars Doors InternalD.. Lights Sensors Wheels

There are many different parts, but most of them are self-explanatory. In this section, you will
know more about the mandatory parts and how to set them properly on your custom profile.

The mandatory parts are:

Physical Wheels (physics based trains only)
Visual Wheels

Front and Back Couplers

Default Joint Anchor (wagons only) (physics based trains only)
Rail Sensors (physics based trains only)
Suspension Colliders (physics based trains only)
Colliders

Wheels SFX

Wagon Connection SFX (wagons only)

Engine SFX (locomotives only)

Brakes SFX (locomotives only)

Horn SFX (locomotives only)

Bell SFX (locomotives only)
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Physical Wheels are components responsible for physically interacting with the rails and
keeping the train on the track. It is recommended to always use only two physical wheels,
one at each end (front and rear). Two is the minimum required and by keeping that way you
ensure you won't have unnecessary rail friction.

» AllPrefabs

» ControlZenes

¥ Locomotive_01_Blue
» Locomotive_01

» Doors

» InternalDetails

¥ Wheels

» WheelsTruck_visual (1)
» WheelsTruck_visual (2)
» WheelsTruck_visual (3)
» WheelsTruck_visual (4)

» Lights

> SFX

» TrainJoint_Front

» Trainoint_Back

> Callidare

Note: Starting from v3.3, the physical wheels components don't have wheels models
being rendered on them anymore. Visual and physics elements were separated for better
results.

Visual Wheels are components responsible for rendering the train wheels and the wheels
rotation animation. You can have as many visual wheels as you want.

» AllPrefabs
» ControlZones
¥ Locomotive_01_Blue
¥ Locomotive_01
¥ Doors
» InternalDetails
¥ Wheels
» Suspension

» WheelsTruck_physics (1
» WheelsTruck_physics (2
1)

¥ Lights
> SFX
» TrainJoint_Front

The Front and Back Couplers are components responsible for connecting wagons, either
on the Unity Editor or in-game (Take a look at the Building a Train section for mode details).

The Default Joint Anchor is a component responsible for stabilizing wagons that are not
connected to any train. This anchor was created as a workaround to fix a PhysX issue with
disconnected joints.

Rail Sensors are components responsible to verify if the train is grounded and on rails.
There are two of them (left and right), they must be located on the lower part of the first set
of wheels.
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Suspension Colliders are auxiliary components used to maintain train stability on terrain
elevations. They must be located above the physical wheels components.

» AllPrefabs

» ControlZones

¥ Locomotive_01_Blus
» Locomotive_01

» Doors

¥ InternalDetails

¥ Wheels

» WheelsTruck_physics (1
» WheelsTruck_physics (2
» WheelsTruck_visual (1)
» WheelsTruck_visual (2)
» WheelsTruck_visual (3)
» WheelsTruck_visual (4)

Colliders are prefabs containing the default Unity Colliders. If you intend on creating similar
wagons that share common colliders, you can save them as prefabs and set them at your
custom profile.

The SFX components are prefabs that contain Audio Sources with train related SFXs.

Note: Default parts prefabs are intended to be used as a starting point for creating
working locomotives and wagons. Therefore, it is NOT recommended to edit them directly.

If you wish to take your customization to the next level, by changing wheels models or
using different SFXs for example, you can create custom parts, by duplicating the existing
parts prefabs and customizing them using the default Unity's prefab editing workflow.

5.3. Manual Adjustments

Although the custom wagon creator already creates ready to use locomotives and wagons, it
is recommended to test and validate the generated vehicles and make small manual
adjustments if needed.

5.3.1. Train Wheels Truck

When working with physics based trains, it is possible to set up visual wheels trucks to steer
accordingly to railroad curves. This feature works by copying the steering rotation of a
physics wheel truck to a visual wheels truck. This process is controlled by the Train Wheels
Truck component, which is also responsible for smoothing the rotation before applying it to
the visual wheels trucks to achieve more realistic steering animation.

When creating physics based locomotives and wagons this feature won’t be enabled by
default. In order to enable it, select the visual wheels truck and manually drag a reference of
which steering joint you wish to use as reference for steering.

€ TestScene* =

v \_' Locomotive_01_Blue >
» | Locomotive 01 ¥ o ¥ Train Wheels Truck (Script) @ = #*
» [,/ Doors . Script TrainWheslsTruck @
b | InternalDetails Target Steering Joint IASteeringJuint (Transform) I @
¥ . Wheels

b | Suspension
¥ WheelsTruck_physics (1)
¥l WheelsTruck_physics (2)
b Steeringloint

P L WheelsTruck_wisual (2)
b L WheelsTruck_visual [3)
b L WheelsTruck_visual [4)

./ Lights

JJ EFX

. Trainloint_Front

. Trainloint_Back

./ Colliders

../ Sensaors

., PassengerSensor

.. Bumpers

L VX

YFYYYYY

A
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6. Building a Railroad

In this section you will learn how to build your custom railroad, using the Railroad Builder.

6.1. Railroad Builder

The Railroad Builder is a game object used for creating and editing railroads in the Unity
Editor.

A Railroad Builder is composed of a LOD Group, a Spline component and a Spline Mesh
Renderer component.

| & RailroadBuilder (1) [ ] static =
Tag | Untagged #| Layer | Default s |
P~  Transform il < 8
o ¥ LOD Group - 8
b o [ Spline (Script) il 8
b o [+ Spline Mesh Renderer (Script) e 8

The Spline component is an editor extension for creating Bezier Splines on the Unity Editor.
A Bezier Spline is a curved path (open or closed) composed by one or more Bezier Curves.

This component is responsible for creating and editing the railroad “path” in the Unity Editor.

¥ = [« Spline (Script) [ ! &
Spline | Handles | Terrain | Scene View J
CURVE SETTINGS

Close Loop -
Mew Curve Length 100
Mew Curve Angle ()90

CURVE OPERATIOMS

l =4 add Curve “ M remove Curve I
[ A Left i P Right |
l g Up I l ™ Down I
l I

1 straight Line

Subdivide Curve Dissolve Curve

The Spline Mesh Renderer component is a level design tool to create dynamically
generated meshes. It works by extruding a base mesh segment along a Bezier Spline.

This component is responsible for dynamically generating the rails on your scene.
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v « [¥ Spline Mesh Renderer (Script) [ ' &,

MESH GENMERATIOMN SETTINGS

Spline RailroadBuilder (Spline) ]
Mesh Generation Profile L Raillroad Builder (Physics Based) (SMR_MeshGenel ©
Mesh Generation Method | Manual ¢ |
Mesh Offset ®0 Y0 Zn

Auto Split [

Vertices Limit () B5000
Start Cap o End Cap o

MESH OPERATIONS

l Generate Mesh “ Bake Mesh |
| Connect New Renderer ]l Spawn Caps |

6.1.1. Rail Generation Profiles

The selected rail generation profiles define which type of rails will be generated by the
Railroad Builder.

v = W Spline Mesh Renderer (Script) [ &' %

MESH GEMNERATION SETTINGS

Spline RailroadBuilder (Spline) @
Mesh Generation Profile IﬁRaiIroad Builder (Physics Based) (SMR_MeshGenel @
Mesh Generation Method | Manual ¢ |

Profiles defines which base mesh segment will be extruded during generation, how many
LODs will be used, what materials should be applied, if and what colliders should be used,
what physics materials should be applied for each collider and if there is any caps prefabs
available to close the start and end of the generated railroad.

E Railroad Builder (Physics Based) i =
| Open |
Script SMR_MeshGenerationProfile @
Culling Ratio - 0.05
b Base Mesh LODS
b Materials

b Mesh Colliders

P Physic Materials
Start Cap I StopblockStartingCap @
End Cap W StopblockEndingCap @

Default generation profiles consists of:

e Railroad Builder (Physics Based)
o Generate rails for physics based trains
e Railroad Builder (Spline Based)
o Generate rails for spline based trains
e Empty Generation Profile
o Auxiliar profile used for invisible rails sections

The default generation profiles are located under the “Generation Profiles” folder.
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Assets » WSM Game Studio » Train Centroller_v3 » Railroad Builder » Generation Profiles

Empty Ge.. Railread .. Railroad ...

Note: DO NOT rename or move default generation profiles to another folder. Otherwise,
they will not be assigned automatically when using the unity object creation menu to
create a new railroad builder.

Since physics based trains rely on guide colliders to follow the tracks, physics based
generation profiles must always include references to the default base mesh colliders.

A physic material must also be applied to reduce friction of the generated guide collider.

Railroad Builder (Fhysics Based) i+
| Open |
Script SMR_MeshGenerationProfile @
Culling Ratio -} 0.05
¥ Base Mesh LODS
Size 3
Elerment O QLP_RailsSegment_LODO @
Element 1 W LP_RailsSegment_LOD1 o]
Element 2 WLP_RailsSegment_LODZ (o]
¥ Materials
Size 1
Elerment O L Rails @
¥ Mesh Colliders
Size Z
Element 0 W Railssegment_GuideCaollider_1m_height (o]
Element 1 @iLP RailsSegment_Collider @
¥ Physic Materials
Size 1
Element 0 |- GuideColliderPhysicMaterial | e
Start Cap I Stopblock StartingCap (o]
End Cap ¥ StopblockEndingCap @

Spline based railroads don't require any colliders, which makes them the most performance
friendly solution.

For performance optimization, it is highly recommended to not assign any mesh colliders
and physic materials on Spline based generation profiles.
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E Railroad Builder (Spline Based)

Script SMR_MeshGenerationProfile @
Culling Ratio - 0.05
¥ Base Mesh LODS
Size 3
Element 0 U LP_RailsSegment_LOD0O @
Element 1 W LP_RailsSegment_LOD1 @
Element 2 WLP_RailssSegment_LODZ @
¥ Materials
Size 1
Element 0 @ Rails o}
¥ Mesh Colliders
Size 1]
¥ Physic Materials
Size i
Start Cap I\ StopblockStartingCap @
End Cap I\ StopblockEndingCap @

Note: Spline based trains can run on physics based railroads, but physics based trains
cannot run on spline based railroads. Nonetheless, for performance sake it is not
recommended to use physics based railroads for spline based trains.

You can also create custom Generation Profiles by using the default file creation menu.
Right click on the folder, then navigate to “Create > WSM Game Studio > Spline Mesh
Renderer > Mesh Generation Profile”

Assets > WSM Game Studio » Train Controller_v3 » Railroad Builder > Generation Profiles

Empty Ge.. Railroad .. Railroad ..
Create > W5M Game Studio > Train Controller > |
Show in Explorer Folder Spline Mesh Renderer > Mesh Generation Profile
Open Theme

C# Script

6.1.2. Creating a new railroad

You can create a new railroad on your scene by using the default object creation menu:

e Hierarchy Window

o Right Click on Hierarchy window

o WSM Game Studio > Railroad Builder
e GameObject Menu

o Click on GameObject menu

o WSM Game Studio > Railroad Builder
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= Hierarchy |
Craate 7|

Assets  GameObject  Component  W5M Game Studic

o All

v Q TestScene

L Demao

Copy
Paste

Rename
Duplicate
Delete

Create Empty

30 Object

2D Object

Effects

Light

Audic

Video

ul

WSM Game Studio

Camera

Railread Control Zones
Railroad Builder (Physics Based)
Railread Builder (Spline Based)
Route Manager

Train Spawner

ene

Create Empty Ctrl+Shift+MN
Create Empty Child Alt+Shift+N
30 Object

2D Object

Effects

Light

Audio

Video

ul

W5M Game Studie

Camera
Center On Children

Make Parent

Clear Parent

Set as first sibling Ctrl+=
Set as last sibling Ctrl+-
Move To View Ctrl+Alt+F
Align With View Ctrl+Shift+F

Align View to Selected

Toggle Active State Alt+Shift+A

v v v v w v v

Asset Store Tools  Window  Help

orAll

Railread Control Zones
Railread Builder (Physics Based)
Railroad Builder (Spline Based)
Route Manager

Train Spawner

Alternatively, you
scene.

can also Drag & Drop an instance of the RailroadBuilder prefab into your

Assets » WSM Game Studio > Train Controller_v3 > Railroad Builder >

------U

Baked Mea..

Editar Genaratio...

Maodals Seripts Themes RallreadE-

compatibility.

Note: Prior to version 3.4, this prefab was used to create new railroad builders instances.
It is not needed for this purpose anymore, however it was kept for the sake of backwards

You should never change this prefab directly or save any alterations made to it. It was
created with the sole purpose of being used as a starting point.

If you are using a custom rail generation profile for your game, you can either use the object
creation menu and change the profile manually, or, you can use the default railroad builder
prefab to create a prefab variant that references your custom generation profile.

By using the object creation menu, the newly created railroad builder will automatically
generate the rails based on the selected profile.
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# Scene | & Game
Shaded =

Angle: 909
—
Length: |100 = Hierarchy =
—_—_—————

Create ™

2D || % | <) | -

) TestScene™
> Demo

0

Shift [Hold]: Preview new curve
Shift + Right Click: Add new curve
Ctrl + Left Click: Control points multi-selection

6.1.3. Quick Access Building Menu

The Quick Access Building Menu was designed to be powerful and user friendly at the same
time. It allows the user to quickly create complex railroads with a few button clicks, while
maintaining mathematical precision for both curve length and angle.

When a railroad builder instance is selected on the Hierarchy, the quick access building
access menu will appear on the top left corner of the Scene View.

= Hierarchy = HScene | € Game

Creata = | (arAll Shaded T 2D ':' ) | d T
GGTestScene* =
> Demo Angle; 902
L

Length: 100

By using this menu, you can quickly create, delete and reshape curves to the desired length
and angle.

The new curve length and angle can be adjusted on the quick access menu and/or the unity
inspector.
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Mb v = W Spline (Script) @ = %

Length: |30

Spline | Handles | Terrain | Scene View |

CURVE SETTINGS

Close Loop

New Curve Length

New Curve Angle

CURVE OPERATIONS

| = Add Curve M Remove Curve
| N Left £ Right

| JUp "} Down

| T straight Line

Subdivide Curve

The curve length is measured in meters and affects both the Add Curve and Curve Shaping
operations. The angle property is measured in degrees and affects only the Curve Shaping
operations. By using both, it is possible to create curves of any length and curvature.

In the sample image above, these properties were used to create a 30m long 90° curve (left)
and a 30m long 45° curve (right). In order to reproduce this example, all you need to do is to
adjust the length and angle values and click on the button with the “right arrow” icon in order
to create a curve to the right.

The angle property is limited to 90° in order to make it easier to create perfect circular
shapes, in which the bezier handles are located in the optimal position (according to bezier
splines best practices). However, curvatures greater than 90° can be achieved by using
multiple curves and adding the curve angles values.

For example, if you wish to create a 60m long 180° curve, you can either use two 30m long
90° curves, four 15m long 45° curves or even three 20m long 60° curves.
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Angle; 902

6.1.3.1. Add Curve

H,

The “Add Curve” button creates a new straight “curve” at the end of the railroad,

pointing in the same direction as the tip of the last curve. As mentioned before, the
length of the newly added curve is defined by the “New Curve Length” property

6.1.3.2. Delete Curve

The “Remove Curve” button deletes the last curve of the railroad.

Hx This operation only applies for railroads composed by 2 or more curves

6.1.3.3. Curve Shaping Operations

8:
2,

u
T

The “Left” button reshapes the last curve of the railroad into a perfect curve
pointing to the left. The curvature angle is defined by the "New Curve Angle"
property and can be adjusted at the Quick Access Building Menu.

The “Right” button reshapes the last curve of the railroad into a perfect curve
pointing to the right. The curvature angle is defined by the "New Curve Angle"
property and can be adjusted at the Quick Access Building Menu.

The “Up” button reshapes the last curve of the railroad into a perfect curve pointing
upwards. The curvature angle is defined by the "New Curve Angle" property and
can be adjusted at the Quick Access Building Menu.

The “Down” button reshapes the last curve of the railroad into a perfect curve
pointing to down. The curvature angle is defined by the "New Curve Angle"
property and can be adjusted at the Quick Access Building Menu.

The “Straight Line” operation reshapes the last curve of the railroad into a straight
line pointing to the direction of the first handle of the last curve. It is very useful to
create straight segments pointing in any direction.
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6.1.3.4. Generate Mesh

The “Generate Mesh” button is used to regenerate the railroad mesh, after making
any changes.

When the manual mesh generation method is selected, the Generated Mesh button must be
clicked to apply any changes made to the railroad.

Angle: 90@
—)

Length: |30 v = | Spline Mesh Renderer (Script)

MESH GENERATION SETTINGS

Spline RailroadBuilder (Spline) o]
Mesh Generation Profile L Railroad Builder (Spline Based) (SMR_MeshGener @
Mesh Generation Methaod | Manual

Mesh Offset X|0

Auto Split o

Vertices Limit
Start Cap 4

MESH OPERATIONS

| Generate Mesh Bake Mesh

| Connect New Renderer Spawn Caps

When the realtime mesh generation method is selected, changes will be applied
automatically. In this case, the Generate Mesh button is replaced by the Print Mesh Details
button.

Angle: 202
———

Length: |30 ¥ « [ Spline Mesh Renderer (Script) @ = %

MESH GENERATION SETTINGS

Spline RailroadBuilder (Spline) [o]
Mesh Generation Frofile L Railroad Builder (Spline Based) (SMR_MeshGene| @
Mesh Generation Method | Realtime

Mesh Offset * |0 ¥ |0

Auto Splhit 4

Vertices Limit
Start Cap End Cap

MESH OPERATIONS

I Print Mesh Details Bake Mesh

| Connect New Renderer Spawn Caps

Note: Manual mesh generation is selected by default, since it allows a performance
friendly workflow on any computer.

6.1.4. New Curve Projection (Shift+Click)

The Quick Access Building Menu is a very powerful and precise tool, however, it is restricted
by the New Curve Length and New Curve Angle properties. Of course this is very useful in
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any situation in which curve precision is required, but it can be a bit of a pain when you need
to create irregular shapes quickly.

For example, if you're using the railroad builder to create a railroad on a terrain, curve
irregularity would make it look much more natural then perfect curves.

By using the new curve projection feature, you can manually create curves of any length
and/or curvature in your scene very quickly. All you need to do is hold shift and move the
mouse around to preview the curve (magenta line) and right click to confirm its creation.

Shift [Hold]: Preview new curve
Shift + Right Click: Add new curve
Ctrl + Left Click: Control points multi-selection

When a railroad builder instance is selected, the following shortcut menu will be visible at the
lower left corner of the scene view in order to remind you of this feature.

Shift [Hold]: Preview new curve
Shift + Right Click: Add new curve
Ctrl + Left Click: Control points multi-selection

6.1.4.1. Terrain Projection

When using this technique to add new curves on terrains, the spline control points will
always intersect with the terrain height and a smooth curvature will be created in between
the control points.

This can be very useful to create smooth railroads uphill or downhill.

NOTE: If you wish your terrain elevations to follow your spline or vice versa, please take a
look at the Terraforming and Follow Terrain sections.
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When projecting into terrains, by default the spline handles will be aligned horizontally for
better results.

NOTE: This feature is not restricted only to terrains, you can also project on top of planes
and/or any other colliders in your scene.

6.1.4.2. 2D Projection

If you don’t have a terrain or object to project on, you can also project on “air”, but in this
case the projection will be made into an imaginary horizontal or vertical plane.

By default, if you're looking at your scene at a random orientation, the new curve will be
projected into a horizontal imaginary plane.

Angle; 90°
—)
Length:

Shift [Hold]: Preview new curve
Shift + Right Click: Add new curve
Ctrl + Left Click: Control points multi-selection

However, for better results it is recommended to use the Top Down view when you wish to
project horizontally.
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Angle: 902
——)
Length:

Shift [Hold]: Preview new curve
Shift + Right Click: Add
Ctrl + Left Click: Control points multi-selection

You can also make vertical projections, in that case you need to use the Right View in order
to do that. Also, when working with vertical projection, make sure your spline is oriented
along the Z or Y axis.

Angle: 902
—

Length:

Shift [Hold]: Preview new curve
Shift + Right Click: Add
Ctrl + Left Click: Control points multi-selection

NOTE: If you are working on a 3D scene and need a vertical spline in your scene that is
not oriented in the Z or Y axis, you can use the Right View orientation in order to create
your projection, then rotate your spline transform to the desired direction once it is done.

6.1.5. Manually editing the railroad

The shape of the railroad curves are defined by the position of the control points and
handles. Besides, using the Quick Access Building Menu and the New Curve Projection
features to shape your railroad, you can also manually adjust the position and rotation of the
control points.

6.1.5.1. Single Point Editing

To manually change the position of a control point or handle, first you need to select it with a
left mouse click.

40



When a point is selected, its position or rotation handle will appear on the Scene View,
depending on what tool is selected in the Unity Editor.

IR S B

Use these handles to manually adjust the position and rotation of the selected point.
By changing the position of the points, you can create any shape of curve you want.
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The selected point position and normal values can be seen under the Handle tab of the
Spline Component.

It is also possible to change these values directly on the Inspector if you wish so, this is very
useful if you need mathematical precision for any purposes.

¥ = W Spline (Script) il + 8

[ Curve | Spline Terrain Scene View ]

HAMDLES SETTINGS

Handles Visibility | Show All Handles &l
Automatic Handles Spacing () 0,33
SELECTED HANDLE

Position %[0 Rl 215

Mormal ¥ 0 Y1 |z]o

Handles Alignment | Aligned : ]

The Normal property identifies the local upwards direction for that point, it is used as
reference to automatically calculate the rotation along the spline.

By using the rotation handle to adjust a control point normal it is possible to bend the rails.
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6.1.5.2. Multi-selection

You can now edit multiple control points at once. In order to do that, hold Ctrl and left click to
select/deselect control points.

When a spline is selected on the hierarchy, the following shortcut menu will be visible at the
lower left corner of the scene view in order to remind you of this feature.

Shift [Hold]: Preview new curve
Shift + Right Click: Add new curve
Ctrl + Left Click: Control points multi-selection

e Selection Color Code
o Selected: Yellow
o Unselected: Green

In the sample image below, the multi-selection was used to move points 1, 2 and 3 at the
same time.
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Note: Within the context of a bezier spline there is no practical use for handles
multi-selection. For this reason, handles cannot be multi-selected, only control points can
(green points).

However, handles will inherit changes made to the corresponding parent control point for
the sake of consistency.

6.1.6. Terrain Features

Regarding the relationship between railroads and terrains, there are only two possible
outcomes: you can either adjust the railroad to the terrain or adjust the terrain to the railroad.
Luckily for you, this asset supports both.

You can use the Follow Terrain feature to project the spline to your terrain. Perfectly,
adjusting the spline to the terrain elevations.

Alternatively, you can use the Terraforming feature to adjust the terrain to your spline.

¥ = [+ Spline (Script) g =
| Curve | Spline | Handles Scene View |
TERRAIM SETTINGS

Follow Terrain
Terrain Check Distance 20

TERRAFORMING SETTINGS
Terraforming Width

Embankment Width 3
Embankment Slope _——
Terraforming Texture Mone
(Texture 20
| Select
Texture Blending ——

TERRAIM OPERATIONS

| Terrafarm | Paint Terrain

| Backup Terrains [ Restore Terrains

6.1.6.1. Follow Terrain

The “Follow Terrain” property is used to add terrain elevation support without the need of
manually adjusting your railroad to fit your terrain. It works by creating a virtual projection of
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the railroad spline on your terrain. The spline shape is preserved as it is, and the virtual
projection can be used as a reference by the railroad builder to generate the rails.

¥ = [ Spline (Script) oo
[ Curve | Spline | Handles Scene View ]
TERRAIN SETTINGS

IFuIIuw Terrain DJ

Terrain Check Distance [20 |

This technique allows you to use simple flat splines to create complex railroads that will
automatically adjust to any type of terrain elevation.

For example, let's assume you wish to build a circular railroad.

First, you build a simple flat spline on the desired shape, but you realize that a segment of
the railroad is passing through the terrain elevations, as shown in the sample image below.

Spline Settings

Follow Terrain

Since buried rails make no sense, you wish to adjust your railroad to your terrain. This can
be easily achieved by enabling the “Follow Terrain” feature.

Spline Settings

Follow Terrain

NOTE: The railroad spline shape remains unchanged, even though the rails mesh is now
being projected on the terrain.

6.1.6.1.1. Terrain Check Distance

The Follow Terrain is a very powerful feature, however, when working with very long splines,
it can become performance heavy for the Unity Editor, since it needs to check the exact
position on space that the railroad spline vertically intersects the terrain for every new
segment created.
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Since the vertical intersection can be located on an infinite number of spatial points below or
above the spline, to avoid performance issues, this feature is limited by the "Terrain Check
Distance" property.

The “Terrain Check Distance” property defines how far from the railroad the “Follow Terrain”
feature should look for the terrain intersection.

¥ = [ Spline (Script) il = 8
[ Curve | Spline | Handles Scene View ]
TERRAIN SETTINGS

Fallow Terrain
Terrain Check Distance |20 I

NOTE: By default the “Terrain Check Distance” is set to 20 meters, which means it will
look for the terrain 20 meters downwards and 20 meters upwards, covering a vertical
range of 40 meters.

However, if your terrain height range is greater than 40 meters, you may need to adjust
this value if, and only if, your spline projection does not reach a part of your terrain.

Alternatively, you can also roughly adjust the spline to bring it closer to your terrain until it
reaches the check range. This alternative is performance friendly and can be done quite
quickly.

6.1.6.2. Terraforming

In some situations, you may wish to adjust the terrain heights to match your railroad. For
example, let’s assume you are building a railroad for physics based trains and for the sake of

train stability, you wish your railroad to be as flat and smooth as possible. On top of that, you
also desire to create Track Ballast along your railroad for detailing purposes.

Let's assume you already built your railroad by using a railroad builder that is located 1
meter above the terrain. So, all you have to do now is to adjust the terrain height along the
railroad and apply a rock texture to simulate the track ballast rocks. However, manually
adjusting the terrain heights and textures would be very time consuming. That’'s why the
terraforming operation was created to make this process as simple as a button click.
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v = [¥ Spline (Script) il = 8
[ Curve | Spline | Handles Terrain
TERRAIN SETTINGS

Follow Terrain =

Terrain Check Distance |20
TERRAFORMING SETTINGS

Terrafarming Width
Embankment Width

Embankment Slope

Terraforming Texture

Texture Blending

TERRAIN OPERATIONS

I Terraform I[ Paint Terrain

Backup Terrains ][ Restore Terrains

In order to create the track ballast, just select a rock terrain texture and click on the
“Terraform” button.

Note: The Terraform feature will do the best it can to create a smooth result based on the
selected Terraforming Settings. However, terrains with lower heightmap resolution may
present some terraforming artifacts (non-smooth areas). In these cases, it is
recommended to use the Unity default Smooth Height brush to make minor adjustments
where needed.

6.1.6.2.1. Terrain Backup

Since terraforming terrain painting is a destructive operation (which means, ctrl+z will not
undo terraforming), it is highly recommended to back up your terrains before proceeding with
it. In order to remind you of the importance of backups, this confirmation dialog will pop up
whenever you click on the “Terraform” button.
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Terraforming Confirmation n

WARNIMG: Terraforming is a destructive operation.
Creating a terrain backup before terraforming is highly
recommended

Are you sure you want to proceed?

You can create and restore terrain backups by using the following buttons.

TERRAIM OPERATIONS

Terraform Paint Terrain
Backup Terrains [ Restore Terrains

A terrain backup is just a copy of its terrain data file, saved alongside the original terrain
data. To keep things simple, just think of the backup file as a screenshot of your terrain
settings at the moment of the backup creation.

gl Mew Terrain

# New Terrain_backup

Note: Keep in mind that only 1 backup file per terrain is supported at any moment in time.
Therefore, make sure to only update your terrain backups when you’re happy with the
modifications you’ve made.

In order for the “Restore Terrains” feature to work properly, the backup and the current
terrain size, heightmap and splatmap resolutions MUST BE THE SAME. If you change any
of your terrain settings in your scene or rename your terrains, it is recommended to update
your terrain backups before using the Terraforming or Paint Terrain features.

Note: As a rule of thumb, it is recommended to always update your backups before using
the Terraforming or Paint Terrain operations. That way, you can always use the Restore
Terrains feature to undo the operation in case you wish to change the terraforming settings
and try again.

6.1.6.2.2. Terraforming Settings

The terraforming settings affects the “Terraform” and “Paint Terrains” operations.

TERRAFORMING SETTINGS
Terraforming Width 3
Embankment Width
Embankment Slope

Terraforming Texture Mone
(Texture 20

Texture Blending ' e——
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The “Terraforming Width” property defines how much of the terrain will be “flatten” along your
railroad when using the Terraform operation.

The “Embankment Width” defines how far the terrain smoothing effect will be applied, based
on a smoothing curve defined by the “Embankment Slope” feature.

a1 1 11

If you click on the “Embankment Slope” property in the inspector, the Unity default curve
editing dialog will be shown. You can choose the available presets or manually adjust the
curve. However, keep in mind that the far left value must always be 0 and the far right value
must always be 1.

Note: Both Terraforming and Embankment Width properties are measured in pixels.
Therefore, the affected area may change based on your terrain’s heightmap and splatmap
resolutions.

The “Terraforming Texture” is used to repaint the area affected by the “Terraform” and/or
“Paint Terrains” features.

Note: The “Terraforming Texture” property is used to identify which terrain layer should be
applied on the affected region. In order for the terrain painting to be successful, your
terrain must have a corresponding terrain layer in which the Diffuse texture is the same as
the selected terraforming texture.

You can also adjust how much “Texture Blending” will be applied while repainting. The
blending is more visible at the railroad starting and ending points. By using the default
blending, it will produce a rounded texture blending effect on both ends. This is useful while
painting more natural paths.
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Texture Blending

However, if you wish your path to be squared on both ends, you can drag the blending range
all the way to the end in order to produce this effect. This can be useful for creating “human
made” paths.

Texture Blending g D

6.2. Railroad Operations & Settings

In this section you will find information about useful Railroad Builder operations and settings
that can be used to improve your railroad building workflow.

These operations and settings are distributed among the Spline and Spline Mesh Renderer
components of the Railroad Builder.
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v = [¥ Spline (Script) & 3 %
Spline | Handles Terrain Scene View ]
CURVE SETTINGS
Close Loop -

Mew Curve Length 30

MNew Curve Angle ) [eo |
CURVE OPERATIONS

I == Add Curve “ M Rremove Curve I
I * Left i £ Right |
I J’Up I I ™ Down I
I 1 straight Line I
[ Subdivide Curve “ Dissalve Curve ]

¥ = [ Spline (Script) a
[ Curve Handles | Terrain Scene View ]
SPLINE SETTINGS
Statie [

Flatten Axis [ ¥ $ |

Parallel Spline Direction X|5 Y0

SPLINE OPERATIONS

Operation Target I /None (Game Object) @

[ Split Spline [ Merge Splines [

[ Connect Target [ Bridge Gap [

[ Append Spline H Flatten ]

[ Reset Spline H Reset Mormals ]

l Create Parallel Spline “ Revert Spline ]
¥ = [ Spline Mesh Renderer (Script) G 5 %

MESH GENERATION SETTINGS
]

Spline
Mesh Generation Profile
Mesh Generation Method

« RailroadBuilder (Spline)
Ll Railroad Builder (Spline Based) (SMR_MeshGener ©
|_ Manual #J

Mesh Offset ¥ |0 Y0 Z0

Auto Split o

Vertices Limit ) 65000

Start Cap = End Cap L

MESH OPERATIONS

I i Generate Mesh H Bake Mesh |
][ Spawn Caps |

l Connect Mew Renderer

6.2.1. Close Railroad Loop

The “Close Loop” property defines if the railroad consists of an open or closed path. By
default, this option is disabled, when enabled, it will automatically adjust the last curve of

your railroad to create a closed path.
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v o W Spline (Script)

Spline Terrain Scene View ]

CURVE SETTINGS

Close Loop

New Curve Length

New Curve Angle

In the sample image above, you see an open spline path composed of 6 bezier curves. Now,
let's see what happens when the “Close Loop” property is enabled.

v o (o Spline (Script)

i+
Spline | Terrain Scene View ]

CURVE SETTINGS

ICIose Loop

MNew Curve Length

Mew Curve Angle

As you can see, the last curve was adjusted to create a closed railroad.

Note: When the Close Loop property is disabled, the last curve will be disconnected and
reseted into a straight line.

6.2.2. Subdivide Curve

The “Subdivide Curve” operation divides the selected curve in half, creating two distinct
curves. This operation is useful to create new curves on the middle of the spline.

Note: To select a curve, just select the first control point of the curve.
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6.2.3. Dissolve Curve

The “Dissolve Curve” operation dissolves the selected control points, transforming two
curves into one. It is very useful to remove curves in the middle of the spline.

6.2.4. Splitting a Railroad

The “Split Spline” operation is used to cut one railroad into two railroads. This operation
instantiates a new object on your scene that inherits all the characteristics and components
from the original object. The newly created railroad starts at the cutting point, connected at
the new end point of the previous railroad.

This operation is very useful for removing segments of a railroad, or reducing the size of long
railroads to apply Occlusion Culling for example.

6.2.5. Merging Railroads

The “Merge Splines” operation is the opposite of the Split Spline operation. By using this
operation you can merge two railroads into one.

QTestS(ene"‘

| 2 Demo

Je

| RailroadBuilder (2)

SPLINE OPERATIONS
Operation Target I RailroadBuilder (2)
Split Spline | Merge Splines

Connect Target || Bridge Gap

In the sample image above, the merging operation is being used to merge two railroad
segments into a single railroad segment.

In order to do that, the “RailroadBuilder (2)” was set as the operation target at the Spline
component of the “RailroadBuilder (1)”.

Merging Cenfirmation n

What do you want to do with the merging target?

WARNIMG: Target deletion cannot be undone

Disable Cancel

Once you click at the “Merge Splines” button, the confirmation dialog above will be displayed
in the Unity Editor. You can either choose to delete or disable the target object. In this

52


https://docs.unity3d.com/Manual/OcclusionCulling.html

example, the delete option was selected, therefore only the “RailroadBuilder (1)” object
remains at the scene after merging as can be seen at the sample image below.

£ TestScene*

F . Demo

_®

In the sample above, the “RailroadBuilder (2)” was perfectly positioned at the end of
“RailroadBuilder (1)". But, this may not always be the case. Eventually, you may wish to
merge railroads that are not connected to each other.

When merging disconnected railroads, the gap between the railroads will be closed
automatically.

NOTE: The merging feature will do the best it can to preserve the curve shape of
disconnected railroads, if you don’t want any distortion on the resulting railroad you can
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either move the target railroad position by using the Connect Target operation or close the
gap prior to merging using the Bridge Gap operation.

6.2.6. Connect Target Object

In some situations, you may need to reposition an object on your scene to the end of a
railroad. You can use the “Connect Target” operation in order to do that.

SPLINE OPERATIONS

COperation Target I RailroadBuilder (2)

Split Spline | Merge Splines

I Connect Target || Bridge Gap

In the following example, the connect operation was used to move the “RailroadBuilder (2)”
to the end of the selected railroad, in order to align both railroad segments.

NOTE: This operation is very useful for level design, as it allows you to connect not only
other railroads, but any object to the end of your railroad.

6.2.7. Bridge Railroad Gap

Consider the following situation: you have a gap between two railroads in your scene and
you want to close it using a new curve.

SPLINE OPERATIONS
Operation Target | RailroadBuilder (2)

Split Spline | Merge Splines

Connect Target || Bridge Gap I
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In order to do this, you can use the “Bridge Gap” operation. It will create a new curve and
automatically adjust the last point position to close the gap between the objects.

6.2.8. Append Railroad

Both “Append Spline” and “Connect New Renderer” operations can be used to create a new
railroad at the end of the current selected one. The newly created railroad inherits all the
characteristics and components from the original object. However, the new railroad is
generated with only one straight curve segment.

SPLINE OPERATIONS

Qperation Target Mone (Game Object) @
Split Spline Merge Splines
Connect Target Bridge Gap
| Append Spline ]| Flatten |

MESH OPERATIOMNS

| Generate Mesh || Bake Mesh |

| Connect New Renderer || Spawn Caps |

6.2.9. Flatten Railroad

The “Flatten” operation sets all control points and handles at the same level of the first
control point of the railroad spline, transforming a 3D into a “2D spline”. The spline
dimension that will be “removed” when using this operation is defined by the Flatten Axis
property.

| Curve m Handles | Terrain | Scene View

SPLINE SETTINGS

Static 4
Flatten Axis Iy |
Parallel Spline Direction ¥|5 ¥ |0
SPLINE OPERATIONS
Operation Target Mone (Game Object) @
Split Spline Merge Splines
Connect Target Bridge Gap
Append Spline Il Flatten |
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Note: The Flatten spline feature is a legacy feature from v2.0 that was originally designed
as a quick way to undo the old version of the Follow Terrain feature that was deprecated.

On version 3.0, the Follow Terrain feature was completely re-written for better results. The
Flatten operation was kept, since it still can be useful in some situations.

In version 3.4, the Flatten Axis property was introduced in order to extend this feature's
usefulness to converting 3D splines into 2D splines.

6.2.10. Reset Railroad Normals

The “Reset Normals” operation removes custom “rotation” of all control points and handles.
It is very useful if you have rotated any points by mistake or wish to remove all custom
rotations.

Reset Mormals Confirmation nl

Are you sure you want to reset all control points
normals?

6.2.11. Reset Railroad Spline

The “Reset Spline” operation completely resets the railroad spline to its initial state: only one
straight curve segment. This operation is useful if you want to recreate your railroad from
scratch.

Spline Reset Confirmation nl

Are you sure you want to reset this spline?

6.2.12. Create Parallel Railroad

If you need to create parallel railroads on your scene, you can use the “Create Parallel
Spline” operation instead of manually building another railroad.

All you need to do is to feed the desired direction and distance on the “Parallel Spline
Direction” property and click the “Create Parallel Spline” button.
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v = [+ Spline (Script) @ = %,

[ Curve m Handles Terrain Scene View ]

SPLIME SETTINGS

Static o
Flatten Axis [ ¥ 4
Farallel Spline Direction X|5 Y0
SPLINE OPERATIONS
Operation Target Mone (Game Object) ]
Split Spline Merge Splines

Connect Target Bridge Gap
[ Append Spline H Flatten ]
[ Reset Spline H Reset Mormals ]
| Create Parallel Spline I Revert Spline |

In the sample below, this operation was used to create a parallel railroad 5 meters to the
right of the original spline.

Note: In order to identify the local horizontal axis to create the parallel spline, this feature
makes use of the control points normals. If you have any distortion while creating a
parallel spline, adjust the control points normals and try again.

6.2.13. Revert Railroad Direction

Spline based railroads are directional, by default the start (first control point) is always at the
origin of the railroad builder object.
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Route Editing

Route Index: 4
Route Name Test Route

Drag & Drop Splines Here

RailroadBuilder (1) (Spline) o| A || v || X |

Save Cancel |

The “Revert Spline” operation can be used to revert the railroad direction if needed.

SPLIME OPERATIONS

Operation Target Mone (Game Object) @
Split Spline Merge Splines
Caonnect Target Bridge Gap
| Append Spline [| Flatten |
| Reset Spline [| Reset Normals |
| Create Parallel Spline [ Revert Spline |

Reverting will move the railroad builder to the end of the spline and revert all control points.

Route Editing

Route Index: 4
Route Name Test Route

Drag & Drop Splines Here

RailroadBuilder (1) (Spline) o4 |ly |[ x|

Save Cancel |

Note: Spline based trains can move back and forwards on a railroad. However, the train
direction is tied to the railroad direction.

6.2.14. Spawning Stopblocks

The default rails generation profiles are pre-configured to add stopblocks at the start and end
of railroads. They will spawn automatically whenever a railroad is generated, if the “Start
Cap” and/or “End Cap” properties are enabled.
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Whenever you need to update the railroad caps without regenerating the mesh, you can use
the “Spawn Caps” operation in order to do that. This can be very useful, if you’ve enabled or
disables the start or end caps, but haven’'t made any changes to the railroad.

MESH GENERATION SETTINGS

Spline RailroadBuilder (1) (Spline) @
Mesh Generation Profile U Railroad Builder (Spline Based) (SMR_MeshGer @
Mesh Generation Method | Manual el
Mesh Offset |0 ¥ |0 Z0

Auto Split o

Vertices Limit () 65000
IStar‘t Cap 7 End Cap |E
MESH OPERATIONS

l Generate Mesh “ Bake Mesh |
| Connect New Renderer ]I Spawn Caps |

6.2.15. Auto split

Since Unity has a limit of 65000 vertices per rendered mesh, if you are building a very long
railroad, eventually you may need to split your railroad in order to avoid reaching the limit.

You can manually split by using the Split Spline feature. However, in order to make things
easier, you can also use the Auto Split feature and control vertices limit for each generated
segment.

MESH GEMERATIOMN SETTINGS

Spline RailroadBuilder (1) (Spline) @
Mesh Generation Profile U Railroad Builder (Spline Based) (SMR_MeshGer ©
Mesh Generation Method | Manual aal
Mesh Offset ¥ |0 Y0 Z|0

Auto Split [

Vertices Limit ) | 65000
Start Cap 4 End Cap o
MESH OPERATIONS

l Generate Mesh “ Bale Mesh |
[ Connect Mew Renderer ]l Spawn Caps J
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Whenever you create a new railroad builder, the “Auto Split” feature is enabled by default
and the “Vertices Limit” is set to the Unity default limit (65000).

6.3. Railroad Prefab Export (Mesh Baker)

When you finish editing your railroad, you can bake a static version of it to improve the
performance of your game. This feature saves the generated mesh and creates a ready to
use prefab that can be used to replace the Railroad Builder on your scene.

MESH GENERATION SETTINGS

Spline RailroadBuilder (1) (Spline) @
Mesh Generation Profile U Railroad Builder (Spline Based) (SMR_MeshGer ©
Mesh Generation Method | Manual $ |
Mesh Offset X0 Y0 Z0

Auto Split 4

Vertices Limit () 65000
Start Cap [ End Cap [«
MESH OPERATIONS

l Generate Mesh “ Bake Mesh |
[ Connect Mew Renderer ]I Spawn Caps ]

By clicking on the “Bake Mesh” button the Mesh Baker window will appear.

[t

a
Mesh Baker -

Mesh Baker

MName

Baking Behaviour | Expert And Replace ¥
Save Spline ] Include Caps o
Output Directery  WsSM Game Studie/Train Controller_v2/Railroad Builder/Baked Meshes/

[ Browse Folder ]
| Bake |

This window can also be found under the window menu tab “Window > WSM Game Studio
> Mesh Baker”.

Window Help
Next Window Ctrl+Tab EI
Previous Window Ctrl+5hift+Tab
WSM Game Studio ¥ hMesh Baker
Layouts > Railroad Turnout Creator

Alternatively, it can also be found under “WSM Game Studio > Train Controller > Utilities
> Mesh Baker”
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W5M Garne Studic  Asset Store Tools  Window  Help
Recommended Assets ¥ *
Train Controller ¥ Create »
Support Request Utilities > Mesh Baker

. Documentation Railroad Turnout Creator

By default, the prefabs will be baked into the “Baked Meshes” folder, but you can change the
Output Directory by using the “Browse Folder” button.

To start the baking process, all you need to do is select a name for your prefab, decide if you
want to save the spline and/or include the caps or not and click on the “Bake” button.

Mesh Baker

Mesh Baker

Name [Railroad |
Baking Behaviour | Export And Replace ¢J
Save Spline W Include Caps o

Output Directery  [WsSM Game Studio/Train Contraller_v3/Railroad Builder/Baked Meshes/

Browse Falder ]

Bake ]

The “Bake” feature will automatically save the meshes and the prefab on the selected Output
Directory.

Railroad_D... S:E0GELR R

The meshes are save on a “data” folder alongside the prefab

Railroad_Co.. Railroad_M.. Railroad_M.. Railroad_M...

The generated prefab can be used to replace the Railroad Builder on your scene. This will
reduce the scene loading time and increase performance. If you've let the default “Export
And Replace” baking behaviour, the railroad builder will be disabled and an instance of the
baked prefab will be created on your scene to replace it automatically. If you don’t want the
automatic replacement to happen, select the “Just Export” option instead.
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Mesh Baker -

Mesh Baker
Name |Railroad !
Baking Behaviour | Expart And Replace ¢
Save SpI!ne P Export And Replace r Include Caps o
Output Directary £~ v3/Railroad Builder/Baked Meshes

Just Export
| a—— Y |
| Bake |

Note: If you want to change your railroad in the future you can keep the Railroad Builder
as a disabled object on your scene instead of deleting it. That way you can always make
adjustments and bake the generated mesh again.

If you keep the “Save Spline” option enabled, a copy of the spline used to create this object
will be saved as a child of the baked prefab.

¥ i Railroad_prefab >
| Mesh_LODO
| Mesh_LOD1
| Mesh_LODZ
| Collider_1
| EndPoint

W Railroad_Spline

Note: The saved spline is supposed to be a backup of the original spline used to bake the
prefab, but it can also be used normally by any spline related feature.

6.3.1. Baked Rail Segments

Starting with v3.4, all prefabs created by the Mesh Baker will have a Baked Segment
component attached to them by default.

¥ «« Baked Segment (Script) g ' %,
SEGMENT SETTINGS
End Point L EndPoint (Transform) (o]
Lo]

Operation Target Maone (Game Object)

SEGMENT OPERATIONS
[ Connect Target J

This is an auxiliary component that works just like the railroad builder Connect Target
operation. It was included to make it easier to connect baked railroad segments to each
other, or to any railroad builder instances on your scene.

Note: The EndPoint property holds a reference to the transform located at the end of the
baked segment. It is used as reference by the Connect Target operation. DO NOT change
the endpoint property reference or move the EndPoint child transform manually.
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6.4. Connecting Baked Rails, Railroad Builders and Turnouts

Whenever you need to connect railroad builders, baked rails or turnouts to each other, use
the “Connect Target” operation (railroad builder connect target, baked segment connect

target)

6.5. Building Long Railroads

If you intend to build super long railroads for open world games for example, eventually you
may see a warning like this:

Mesh cannot have more than 65000 vertices,

If you need to go even further, please use the Split Spline operation

Mesh cannot have more than 65000 vertices,

If you need to go even further, please use the Split Spline operation

to reduce the size of your spline and keep building using the newly created spline.
UnityEngine.Debug:LogWarning({Object)

This happens because Unity has a limit of 65000 vertices per mesh. This limit exists to avoid
performance issues when rendering large meshes. This limit is also very useful to apply
Occlusion Culling on your railroad and increase your game performance. If you see this
warning, just follow the instructions below to keep building your long railroad.

Note: The process described below is only necessary if the Auto Split feature is disabled,
as it is a step-by-step guide on how to manually split long meshes manually to avoid
reaching the Unity vertices limit.

With the Railroad Builder object selected, go to the end of your mesh and check if the mesh
ending matches the last control point. It probably won't match, like in the sample image
below.

To solve this issue and keep building, all you need to do is to select the last control point that
was successfully rendered.
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And then use the Split Spline operation to start a new railroad section.

Note: Real time mesh generation is disabled automatically when the max number of
vertices is greater than 65000. This is the default behaviour to increase the editor
performance while building your mesh, since processing large meshes data in realtime is
costly.

You can change back to the real time mesh generation manually after reducing the rails,
but, for very long railroads it's recommended to use the manual mesh generation button to
update the mesh after adjusting your railroad curves.

The max length of each segment depends on the base mesh vertices count. For example,
the base rail mesh included in the package has 56 vertices in total (LODO). By using it, it is
possible to create railroad segments up to 1.35 Km each. To create railroads longer than
1.35 Km, use the technique described above to create multiple railroad segments connected
to each other.
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/. Route Manager

The Route Manager is an auxiliary component that can be used to define and reuse railroad
routes on your scene. It can be used to assign routes to spline based trains, spawn trains on
top of the rails using the Train Spawner or to automatically change spline based trains routes
in-game using railroad switches.

v Q Demo_SplineBasedTrain -

_ EventSystemn

b I Canvas

b Cameras
L TrainSpawner

b Enviroment

b ControlZones

b Train

You can add a new Route Manager on your scene by using the default Unity object creation
workflow: “GameObject > WSM Game Studio > Route Manager” or “Right Click on
Hierarchy > GameObject > WSM Game Studio > Route Manager”

Note: The Route Manager is designed as a Singleton. Only 1 Route Manager is
necessary per scene.

7.1. Creating a New Route

By using the route manager, you can create, edit and delete routes on your scene.

¥ = [+ Route Manager (Script) [ 3 #&

Route Settings Route Operations

ROUTE SETTINGS

ROUTES

0 - Loop 1 | Edit || Delete |
1- Loop 2 | Edit || Delete |
Z-Lloopl = Loop 2 | Edit || Delste |
3-Loop 2 = Loop 1 [ Edit H Delete ]
| MNew Route |

Note: A route is composed of one or more splines. The splines referenced on a route, can
be part of a Railroad Builder, Baked Rail Segment and/or Railroad Switch.

To create a new route, click at the “New Route” button. Newly created routes, will be shown
in red to inform that no splines were assigned yet.
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¥ « [+ Route Manager (Script)

Route Settings

Route Operations

ROUTE SETTINGS

ROUTES

0-Loopl
1-Loop2
2-loopl = Loop 2
3 -Loop 2 > Loop 1

4 - Route 5 (route splines not assigned)

Edit || Delete
Edit || Delete
Edit || Delete
Edit || Delete
Edit || Delete

I

Mew Route

In order to edit the route name and assign splines to it, click the “Edit” button to open the

Route Editing window.

Route Editing

il 3¢

Route Name

Route Index: 4

Route &

Drag & Drop Splines Here

Save

I

Cancel

Drag & Drop splines from your scene into the yellow box to add them to the route. You can
use the up and down arrows to change the order of the splines assigned to the route. To
remove a spline, click the x button.

Route Editing

il 3¢

Route Name

Route Index: O

Loop 1

Drag & Drop Splines Here

« Railroad_1_Spline (Spling)

°la v J|

-

« Switch_1_Spline_1 (Spline)

°la ¥ J|

=

« Switch_2_Spline_1 (Spline)

°la ¥ JI

=

I

Save

I

Cancel

When the route editing window is open, the selected route will be visible in the Scene View.
Cones are used to identify route direction, yellow cones are used to mark the start and end

of each spline.
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Route Editing

Route Index: 0
Route Name Loop 1

Drag & Drop Splines Here

Railroad_1_Spline (Spline)
Switch_1_Spline_1 (Spline)
Switch_2_spline_1 (Spline)

Save /|

7.2. Assigning a Route to a Train
To assign a route to a train, select the target train locomotive, then select a route and click

the “Assign Route” button.

¥ « v Route Manager (Script) Q3
[ Route Settings Route Operations

ROUTE OPERATIONS

Target Locomotive s_Locomotive_01_Blue @
Position Along Rails -, 0.5
Route selection | Loop 1 t Assign Route |

Note: The Route selection drop down will contain all valid routes available on your scene.

To verify if the route was applied successfully on a spline based train, you can check the
target locomotive “Route Splines” property.

v = [ Spline Based Locomotive (Script) @ ' %
Wagons | Lights WFH/SFH Other Settings ]

TRAIN CONTROLS

Engines On o

Max Speed 300 | Kkph |
Acceleration \_,-1—
Automatic Brakes o

Brake ., i}
Acceleration Rate 15

SPLINE SETTINGS
% Route Splines

Size 3
Element 0 Railroad_1_Spline (Spline) <]
Element 1 Switch_1_Spline_1 (Spline) <]
Element 2 Switch_2_Spline_1 (Spline) (]
— —
Follower Behaviour | Loop 4|
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8. Train Spawner

The Train Spawner is an auxiliary component that can be used to spawn locomotives,
wagons and/or complete trains on your scene.

b J ﬂDemn_SplineBasedTrain =

_ EventSystem

# | ICanvas

b Cameras
. RouteManager

b | Enviroment

b ControlZones

b Train

You can add a new Train Spawner on your scene by using the default Unity object creation
workflow: “GameObject > WSM Game Studio > Train Spawner’ or “Right Click on
Hierarchy > GameObject > WSM Game Studio > Train Spawner”

Note: The Train Spawner is designed as a Singleton. Only 1 Train Spawner is necessary
per scene.

The Train Spawner was designed to make it easier to spawn trains on top of railroads.
Therefore, in order to use it, you need to have at least one railroad already built and
assigned to a route. For more detail about routes, please take a look at the Route Manager
section.

Target Route | 0 - Loop 1
Position Alang Rails v 0-Loop1
1-Loop2

E 2-Loop 1> Loop 2
3-

Loop 2 = Loop 1

The Target Route drop down will load automatically all routes available in your scene as
shown in the sample image above. If a route manager is not found, a warning message will
be shown instead.

W o Train Spawner (Script) @ = %,
Spawn Train (Profile) | Spawn Train (Prefah) ]
Locomotive/Wagan Prefab INone (Game Object) 2]
Paosition Along R ails i 0.5

Spawn
Route Manager not found

The “Position Along Rails” property is a range between 0 and 1 that defines the percentual
position along the selected route. By default it is set to 50% (0.5).
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8.1. Spawning Railway Vehicles

You can spawn single locomotives and/or wagons on your scene. This is useful to distribute

wagons along your railroad for the in-game wagon connection feature.

To spawn a new railway vehicle instance on your scene:
e Select the locomotive or wagon prefab
e Select target route
e Adjust position along rails (if needed)
e Click on Spawn

¥ «  Train Spawner (Script) [ & %

Spawn Rallway Vehicle Spawn Train (Profile) | Spawn Train (Prefab) ]

Lacomative/Wagon prefab 0
Target Route |o-Leep: 4]
Position Along R ails . [os |
| Spawn |

8.2. Spawning Trains

You can spawn complete trains on your scene either by using a train profile or a ready to use

train prefab.

physics based trains should be spawned on straight rails segments.

Note: Spline based wagons will automatically follow railroad curves on spawn. However,
physics based wagons are spawned on a straight line behind the locomotive, therefore,

8.2.1. Spawn Train Profile

A train profile defines which locomotive and wagons prefabs will be instantiated to spawn the

train.

6 Inspector =

Freight Train Sample Profile (Spline Based) i+ 8

| open |
Script TrainProfile @
Locomotive Prefab Ws_Locomotive_01_Blue @

¥ Wagons Prefabs

Size 8

Elerment O \ws_PlatformWagon_Black_13 4 @
Element 1 s_PlatformWagon_Black_13_4 BlueContainer @
Element 2 s_PlatformWagon_Black_13_4_ GreenContaini @
Element 3 s_PlatformWagon_Black_13_4 RedContainer @
Element 4 i#s_PlatformWagon_Red_13_4 @
Element 5 \ws_PlatformWagon_Red_13 4 BlueContainer @ @
Element & s_PlatformWagon_Red_13_4 GreenContainer @
Element 7 s_PlatformWagon_Red_13_4 RedContainer @ @

Sample train profiles are included alongside the sample train prefabs.
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Assets » WSM Game Studio » Train Controller_v3 » Prefabs > Sample Trains

<<y | ]

Freight Tr.. Freight Tr.. Train_Long Train_Sa.. Train_Sa..

Note: Train profiles are Scriptable Objects, which means, you can create your own
custom train profiles either by duplicating an existing profile file or by using the Unity Editor
creation menu:

Right Click > Create > WSM Game Studio > Train Controller > Train Profile

To spawn a new train instance on your scene:
e Select a train profile
e Select target route
e Adjust position along rails (if needed)
e Click on Spawn

W cu Train Spawner (Script) [ 5 %,
[ Spawn Railway Vehicle Spawn Train (Profile) Spawn Train (Prefab) ]
Train profil o
Target Route | 0 - Loap 1 : ]
Position Along R ails i [os |
I Spawn I

8.2.2. Spawn Train Prefab

A train prefab is composed of a locomotive and wagons (connected to each other) set as
children of an empty game object as saved as a prefab. For more information on how to
create train prefabs, please take a look at the Connecting Wagons (Editor) section.

£ I Train_Sample_1

B | Locomeotive_01_Orange_Black

B | PlatformWagen_Black_13_4

B | PlatformWagen_Black_13_4_ BlueContainer
b | PlatformWagen_Black_13_4_ GreenContainer
b | PlatformWagen_Black_13_4_ RedContainer

Note: The wagons of a train prefab must be referenced at the corresponding locomotive
wagons list.

To spawn a new train instance on your scene:
e Select a train prefab
e Select target route
e Adjust position along rails (if needed)
e Click on Spawn
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¥ o

Train Spawner (Script)

@ %,

Spawn Railway Vehicle |

Spawn Train (Profile)

Train Prefab
Target Route
Position Along Rails

Train_Sample 1 @

0-Lloopl H

Spawn I
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9. Railroad Switches (Turnouts)

In this section you will learn how to use, signalize and create custom Railroad Switches
using the “Railroad Turnout Creator”.

9.1. Physics based switches

Physics based railroad switches works by enabling/disabling the rails “Guide Colliders” to
redirect the trains in the desired direction. This behaviour is controlled by the
“RailroadSwitch_v3” component.

n 'mnmmnnmmmnmmmnmmmﬂwmmmm!mnmmmm..
a0 S S 0 S0 B 540 S0 S8 0 S0 AT CA 40 00 Y
Cigi]

W T O W s P I O O G W L B I W W
340 S0P A AN 30 A S S S0 ) 283 S S

D AN AD s S 3 S (53 50 '
¥

You can change the initial direction of a physics based switch in your scene by using the
“Switch Rails” button on the inspector.

¥ =  Railroad Switch_w 3 (Script) @ =
Spline Based Events ]
SETTINGS
Rails Colliders
OPERATIONS
| Switch Rails |
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For example, this is the same railroad switch, after switching the active rails.

9.2. Spline Based switches

Spline based railroad switches works by changing spline based trains current route at
runtime.

¥ «  Railroad Switch_wv 3 (Script) Q@ = #.

[ Physics Based Spline Based Events ]
SETTINGS

Available Routes | 0-Loop 1 | Add Route |

SELECTED ROUTES

0-Loop 1 | Remove |
1-Loocpl > Loop 2 | Remove |
2 - Loop 2 | Remove |

The routes affected by the railroad switch needs to be selected under the “Spline Based” tab
of the RailroadSwitch component.

Note: Spline based switches depend on pre-existing railroad routes on your scene. For
more detail about routes, please take a look at the Route Manager section.

9.3. Automated switches

Switches can be activated automatically when a train enters a Switch Trigger Zone.

You can add a new Switch Trigger Zone on your scene by using the default Unity object
creation workflow: “GameObject > WSM Game Studio > Railroad Control Zones >
Switch Trigger Zone” or “Right Click on Hierarchy > GameObject > WSM Game Studio
> Railroad Control Zones > Switch Trigger Zone”

Switch Trigger Zones can activate one or more Railroad Switches at the same time. You just

need to drag & drop the railroad switches you want to control to the “Railroad Switches”
property of the Trigger in your scene.
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W |cx Switch Triqﬁer (Script)

GENERAL SETTINGS

Railroad Switches

Size 1

Element 0 RailSwitch_100mx20m_Parallel Rever o
Switch Mode (Always 4

SPLINE BASED SETTINGS
Left Route Index V] Right Route Index

Note: Railroad switches can also be activated manually by calling the “SwitchRails”
method of the “RailroadSwitch_v3” component.

Switch Trigger Zones are a powerful way to automate your railroad. It allows you to create
custom complex railroad traffic control within minutes, just by selecting the desired switching
mode.

¥ o« Switch Trigger (Script) [ -

GENERAL SETTINGS

Railroad Switches

Switch Mode | Alwrays B
SPLINE BASED SETTINGS ¥ Ahways
Left Route Index Once 1 I
Random
[ - -
If Activated
If Deactivated

You can choose to switch the direction of the rails every time a train hits the trigger (always),
only once, randomly or only if the turnout is activated or deactivated.

“If Activated” and “If Deactivated” are useful to avoid derailing by creating safety check
triggers before each railroad turnout.

Random activation is controlled by the “Random Switch Probability” property, so you can fine
tune the switch to activate more or less often. This property is only visible when the random

switch mode is selected.

¥ o« Switch Trigger (Script) @ 3 %

GENERAL SETTINGS
Railroad Switches

Switch Mode [ Random |
Random Switch Probability - s |

SPLIME BASED SETTINGS
Left Route Index 0 Right Route Index 1
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The Left Route Index and Right Route Index properties are used to identify which routes are
affected by the switch trigger when using spline based trains.

W oo Switch Trigger (Script) & = %

GENMERAL SETTINGS

Railroad Switches
Switch Mode | Alwrays

ar

SPLINE BASED SETTINGS
Left Route Index ] Right Route Index 1

The indexes are numbers corresponding to the Selected Route indexes in the Railroad
Switch component. By default the indexes are set to 0 and 1, which corresponds to the first
two selected routes.

¥ «  Railroad Switch_w 3 (Script) (=i =

[ Physics Based Spline Based Events ]
SETTINGS

Available Routes |0-Loap 1 H Add Route J

SELECTED ROUTES

0f- Loop 1 [ Remaove ]
1)- Loop 1 = Loop 2 [ Remove ]
2)- Loop 2 [ Remove ]

The “OnActivate”, “OnDeactivate” and “OnSwitch” event stacks can also be used to trigger
custom events on your game as you wish. For example, they can be used for sinalization
(see Switch Sinalization section for more details)

¥ «  Railroad Switch_v 3 (Script) @ = %,
[ Physics Sased | Spiine Based
CUSTOM EVENTS
on Activate ()
List is Empty
+
0on Deactivate ()
List is Empty
+
on Switch ()
List is Empty
+

9.4. Switch Signalization

Under the “Prefabs/Sinalization” folder you will find the “Directionindicator_01" prefab.
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Assets » WSM Game Studio » Train Controller_v3 » Prefabs > Sinalization

Direction.. | Stopbloc.. Stopbloc..

It is a ready to use animated direction indicator based on old real world direction indicators. It
can point right, left or forward (default position)

Drag & Drop it to your scene and place it next to the railroad switch you want to sinalize.
Select the railroad switch object on your scene and use the “OnActivate” and “OnDeactivate”
event stacks to call the “TurnRight”, “TurnLeft” or “ReturnToDefaultPosition” methods like in
the sample image below.

ot Railroad Switch_wv 3 (Script)
Physics Based | Spline Based

CUSTOM EVENTS
On Activate ()

[ Runtime Only % ] [ DirectionIndicator, TurnRight
| Directiunlndicator_l:lﬂ

On Deactivate ()

| Runtime Only 4 || DirectionIndicator.ReturnToDefaultPosition
|« DirectionIndicator_o o|

On Switch ()
List is Empty

9.5. Custom Turnouts Creator

You can create custom railroad switch prefabs by using the built-in Railroad Turnout Creator.

W5M Garne Studic  Asset Store Tools Window  Help

| Recommended Assets b I
Train Controller b Create > Imp
Support Request Utilities > Mesh Baker
SETL Documentation Railroad Turnowut Creator
Write a Review Custom Wagons Creator

It can be found under “WSM Game Studio > Train Controller > Utilities > Railroad
Turnout Creator”
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o
Il

Raillroad Turnout Creator ] =

Railroad Turnout Creator

Main Rails MNone [Game Object) o
Turnout Rails None (Game Object) 2
Parallel Rails (optional) None (Game Object) 9
Marme

Output Directory WSM Game Studio/Train Controller_v3/Prefabs/Turnouts

[ Browse Folder ]
| Create |

Instructions

1) Drag & Drop the rails (Baked Segments) prefabs to the scene
2) Select a name and output falder

3) Select the rails segments from your scene

4) Click on the Create Button

Custom railroad turnouts are built using baked rail segments. Custom rail segments with any
length or curvature can be created by using the Railroad Builder and Mesh Baker (See
Building a Railroad section for more details)

Note: When building custom turnouts for spline based trains, make sure to save the
spline when exporting baked rails segments using the mesh baker.

Drag & drop the rail segments on your scene and move them into the desired position. If
needed, the connect target operation can be used to move the rail segments.

‘= Hierarchy m-= | #Scene | € Game
Create 7| (crAll Shaded

v QTestScene* =
> Demo

b Testing

® Rails_100m_prefab (1)
# Rails_Switch100m_Right_prefab
# Rails_100m_prefab (2)

Open the Turnout creator window, drag & drop the rail segments on your scene into the
corresponding rails field, select a name for your custom turnout and click on “Create”.
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o
Il 3

Railroad Turnout Creator ] o

Railroad Turnout Creator

Main Rails WwRails_100m_prefab (1) o
Turnout R ails W Rails_Switch100m_Right_prefab 2]
Parallel Rails (optional) (yRails_100m_prefab (2) o]
Mame |Sample_Turnout |
Qutput Directory WSM Game Studio/Train Controller_v3/Prefabs/Turnouts

[ Browse Folder J
| Create |

Instructions

1) Drag & Drop the rails (Baked Segments) prefabs to the scene
2) Select a name and output folder

3) Select the rails segments from your scene

4) Click on the Create Button

Note: “Main rails” and “Turnout Rails” segments are mandatory. “Parallel Rails” are
optional.

If done correctly, the prefab will be saved on the selected output folder.

Assets » WSM Game Studio > Train Controller_v3 » Prefabs » Turnouts

RailSwitc.. RailSwitc.. RailSwitc.. JSample_T..

The rail segments used to build the turnout will also be replaced by an instance of the newly
created turnout on your scene.

‘i= Hierarchy & -= | #Scens | € Game
Create = | (arAll Shaded | |2D .':'-;‘:'.4]:' d |~
v QTestﬁcene* =
> Demo
P Testing

#® Sample_Turnout

Note: The rail segment that was selected as “Turnout Rails” during the creation process
will be disabled by default.
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10. Train Stations

In this section you will learn how to simulate train stations

10.1. Stopping at a Station

In the “Prefabs/Control Zones” folder you will find the “StationStopZone” prefab.

Assets » WSM Game Studio > Train Controller_v3 » Prefabs > Control Zones

vy

Bellactiva.. BellDeact. CustomE.. HonkZone ReverseDi.. SpeedCh.. CELElka) SwitchTri..

It can be used to simulate train station stops. Once a train hits a “StationStopZone” trigger, it
will start braking until it stops.

= Hierarchy | ® = # Scene ] € Gam
| Create ~ ar All Shaded =
v QTrainStatiunDemu =
_ EventSystem

k| Canvas

b Cameras

b Enviroment

¥ |/ ControlZones

W SpeedChangeZone (1) >
W SpeedChangeZone (2) »
W SpeedChangeZone (3) »
W SpeedChangeZone (4) »
by Train_Long »

79



You can configure when the train should stop and how it behaves at the station after
stopping.

¥ =  Station Stop Trigger (Script) 3 3 %,
Script StationStopTrigger @
Stop Mode | Always al
Station Door Direction | Both Sides il
Station Behaviour | Leave After Time sl
Stop Timeout 5
Random Stop Probability . 50
Turn Off Engines -

You can choose to always stop, stop only once or randomly stop at the station.

Random activation is controlled by the “Random Stop Probability” property, so you can fine
tune if the train will stop more or less often.

¥ =  Station Stop Trigger (Script) g ' %,
Script StationStopTrigger ]
Stop Mode | Always ¢ |
Station Door Direction v Always ¢ |
Station Behaviour $ |

Once

Stop Timeout
Random Stop Probability Random [so |
Turn Off Engines -

The “Station Door Direction” property is used to open train doors automatically after
stopping. It defines which side of the train the doors should open for that station.

¥ o Station Stop Trigger (Script) [ 5 %
Script StationStopTrigger @
Stop Mode [ Always &
Station Door Direction | Both Sides ¢ |
Station Behaviour + Both Sides ¢
5t Ti t

op Timeou - Left
Random Stop Probability p——| (]
] Right

Turn Off Engines

You can also choose to leave the station after some time or stay forever. The “Stop Timeout”
property defines how many seconds the train will remain on station before leaving.

¥ =  Station Stop Trigger (Script) il - 8
Script StationStopTrigger 2]
Stop Mode | Always al
Station Door Direction | Both Sides s
Station Behaviour | Leave After Time ™
Stop Timeout »  Leave After Tme
Random Stop Probability 50

i Stop Forever
Turn Off Engines

The “Turn Off Engines” can also be used to stop the train on a final destination if needed.
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10.2. Station Custom Events

You can call a custom event stack whenever a train is arriving or leaving a station. These
events are:

e Arriving At Station Events
o OnBrakesActivation()
o OnStop()
o OnAfterStopping()

e Leaving Station Events
o OnLeaveWarning()
o OnBeforeLeaving()
o OnLeave()

Custom events should be set at the Train Station Controller component attached to each
locomotive.

¥ = [¥ Train Station Controller (Script) @ ' %,
Script TrainStationController 2
Leave Warning Time 3

On After Stopping Event Time |1

On Before Leaving Event Time |1
On Brakes Activation ()

List is Empty

+
on Stop ()
List is Empty

+
On After Stopping ()
List is Empty

+
On Leave Warning ()
List is Empty

+
On Before Leaving ()
List is Empty

+
on Leave ()
List is Empty

+
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10.3. Train Doors

This package includes train doors open and close animations made with Mecanim, which
means you will be able to customize the animations in the Unity Editor if you wish so.

Assets » WSM Game Studio » Train Controller_w3 » Shared » Animation

BellAnima.. Bellldle BellPlaying Direction. Door_Ani.. DoorClose Doorldle Door@pen  Turn_90d.. Turn_90d..

By default, when the train reaches a station it will automatically open the passenger doors, if
any (See the Train Stations section for more details).

But, if you wish to open/close the doors at any other time, you can call the open/close
methods directly from a button click event or from a custom script for example. All you need
to do is to call the methods from the TrainDoorsController component attached to your
locomotive.

e Open Door Methods
o OpenCabinDoorLeft()
o OpenCabinDoorRight()
o OpenPassengerDoors()
e Close Door Methods
o CloseCabinDoorLeft()
o CloseCabinDoorRight()
o ClosePassengerDoors()

You can also call these methods in the Unity Editor by using the buttons available on the
Train Operations section of the Train Controller script. This is useful to test your custom
train doors.

‘!’ [+ Train Controller_v 3 (Script) [7] %%,
Controls Wagons | Lights SFx Other Settings]

TRAIMN CONTROLS

Engines On [+

Max Speed (KPH) () |B5—|
Acceleration :}:Il—l
Automnatic Brakes o

Brakes O IU—l
TRAIM OPERATIONS

Stop Engine
Open Left Cabin Doar Cpen Right Cabin Doar
Open Left Passenger Door ][ Open Right Passenger Door

Note: Door related operations are only enabled on Play Mode.
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10.4. Attaching Passengers

This package includes a simple method for attaching passengers and objects to trains and
carrying them as passengers or cargo.

By default, all attached objects are set as children and inherit the wagon's movement. It is
the same technique used to attach characters to moving platforms.

It works by attaching automatically objects tagged as any of the configured passengers tags
to the wagons, if the object is positioned inside a wagon. These tags are set at the
“Passenger Tags” component attached to locomotives.

v = [¥ Passenger Tags (Script) @ = %
Script FPassengerTags 2]
Kinematic While Moving ]

¥ Passenger Tags

Size 2
Element 0 Player
Elerment 1 NPT

Note: If the ‘Kinematic While Moving“ property is enabled, any physics based object will
be set to kinematic while the train is moving.

Since there are several character controllers available on the market, and even custom
character controllers developed for singular projects, it is not possible to guarantee all
character controllers will behave properly while attached to a wagon.

It all depends on how your character controller handles movement. For example, character
controllers that use animation root motion, may not inherit parent objects movement, since
the animation root motion can override the character position.

In general, if your character controller works properly with simple moving platforms and
properly inherits position and rotation when set as children of a moving game object, it
should work fine.

Note: Keep in mind that physics based trains will shake at higher speeds, just like real
world trains. This could cause minor involuntary movement (sliding) on physics based
character controllers, caused by the physics engine handling collisions and inertia. It may
also induce motion sickness on First Person Character controllers.

If you intend to have passengers or characters riding the trains it is highly recommended
to use spline based trains on your project.
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11. Scripting Reference

This section contains information about useful public properties and methods that can be
safely accessed by custom scripts.

11.1. Locomotives and Wagons

e ILocomotive Properties

O

0 0O 0O 0O 0O O 0O 0O O O O

(©]

bool EnginesOn { get; set; }

float Acceleration { get; set; }

bool AutomaticBrakes { get; set; }

float Brake { get; set; }

float MaxSpeed { get; set; }

SpeedUnits SpeedUnit { get; set; }

bool BellOn { get; }

float Speed_MPS { get; }

float Speed KPH { get; }

float Speed_MPH { get; }
ITrainDoorsController DoorsController { get; }
GameObject GetGameObject { get; }
List<GameObject> ConnectedWagons { get; }

e |ILocomotive Methods

(@]

o O O O O O O O O

O

void ToggleLights();

void TogglelnternalLights();

void Honk();

void ToogleBell();

void ToggleEngine();

void UpdateDoorController();

void AddWagons(List<GameObject> newWagons);
void RemoveAllWagons();

void CalculateWagonsPositions();

void CalculateWagonsPositions(List<Spline> targetRails);
void AssignRoute(Route newRoute, float t);

¢ IRailwayVehicle Methods

O

O

void ToggleLights();
void TogglelnternalLights();

e ITrainDoorsController Properties

StationDoorDirection StationDoorDirection { get; set; }
bool CabinLeftDoorOpen { get; }

bool CabinRightDoorOpen { get; }

bool PassengerlLeftDoorOpen { get; }

bool PassengerRightDoorOpen { get; }

e ITrainDoorsController Methods

O

o O O O O O

void OpenCabinDoorLeft();

void OpenCabinDoorRight();

void CloseCabinDoorLeft();

void CloseCabinDoorRight();

void OpenPassengersDoors();

void OpenPassengersDoors(StationDoorDirection doorsDiretion);
void ClosePassengersDoors();
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O

O

(@]

void ClosePassengersLeftDoors();
void ClosePassengersRightDoors();
void UpdateWagonsDoorsControllers();

Note: Both TrainController_v3 (physics based locomotives) and SplineBasedLocomotive
scripts inherit from ILocomotive and IRailwayVehicle interfaces.

Wagon_v3 (physics based wagons) and SplineBasedWagon scripts inherit only from the
IRailwayVehicle interface.

11.2. Railroad Builder & Baked Rails Segments
e Spline Properties

(@]

O 0O 0O O O O 0O O 0O o o O o o

O

bool Loop { get; set; }

float NewCurvelength { get; set; }

float NewCurveAngle { get; set; }

bool StaticSpline { get; set; }

Vector3Axis FlattenAxis { get; set; }

Vector2 ParallelSplineDirection { get; set; }
HandlesVisibility HandlesVisibility { get; set; }
float AutoHandleSpacing { get; set; }

bool FollowTerrain { get; set; }

float TerrainCheckDistance { get; set; }

int TerraformingWidth { get; set; }

int EmbankmentWidth { get; set; }
AnimationCurve EmbankmentSlope { get; set; }
Texture2D TerraformingTexture { get; set; }
float MinTextureBlending { get; set; }

float MaxTextureBlending { get; set; }

e Spline Methods

O

0O 0O 0O 0O O 0O oo oo o o o o o o o

O

void AddCurve()

void AddCurve(Vector3 point, Vector3 upwardsDirection)
void RemoveCurve()

void ShapeCurve(Vector3 direction)

void ResetLastCurve()

void SubdivideCurve(int selectedindex)

void DissolveCurve(int selectedindex)

void SplitSpline(int selectedindex)

void Merge(GameObject target, bool deleteTarget, bool disableTargetlfNotDeleted)
void ConnectTarget(GameObject target)

void BridgeGap(GameObject target)

GameObject AppendSpline()

void Flatten()

void Reset()

void ResetNormals()

GameObject CreateParallelSpline()

void Terraform(bool setHeights, bool paintTextures)

void BackupTerrains()

void RestoreTerrains()

e SplinMeshRenderer Properties
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o O O O O O O

O

Spline Spline

SMR_MeshGenerationProfile MeshGenerationProfile
MeshGenerationMethod MeshGenerationMethod
Vector3 MeshOffset

bool AutoSplit

int VerticesLimit

bool StartCap

bool EndCap

e SplinMeshRenderer Methods

O

o

o

O

void ExtrudeMesh()

void PrintMeshDetails()

GameObject ConnectNewRenderer()
void SpawnCaps()

e BakedSegment Properties

O

(@)

Transform EndPoint { get; set; }
GameObject OperationTarget { get; set; }

e BakedSegment Methods

(¢]

O

void ConnectTarget()
void ConnectTarget(GameObject target)

Note: Although, the EndPoind property of a BakedSegment as a “setter” it should not be
changed. This property holds a reference to a Transform located at the end of the baked
segment, that is used as reference by the Connect Target operations.

11.3. Route Manager

e RouteManager Properties

O

o

List<Route> Routes { get; set; }
float PositionAlongRails { get; set; }

e RouteManager Methods

o

o

O

void CreateRoute()

void DeleteRoute(int routelndex)

bool ApplyRoute(SplineBasedLocomotive locomotive, int routelndex, bool
applyCustomPositionAlongRails)

11.4. Train Spawner

e TrainSpawner Properties

O

float PositionAlongRails { get; set; }

e TrainSpawner Methods

(e]

GameObject SpawnTrain(TrainProfile trainProfile, List<Spline> targetRails, float t,
string trainName)

GameObject SpawnTrain(GameObject trainPrefab, List<Spline> targetRails, float t,
string trainName)

GameObject  SpawnTrain(GameObject  locomotivePrefab, List<GameObject>
wagonsPrefabs, List<Spline> targetRails, float t, string trainName)

GameObject SpawnRailwayVehicle(GameObject railwayVehiclePrefab, Vector3
position, Quaternion rotation)

GameObject SpawnRailwayVehicle(GameObject railwayVehiclePrefab, Vector3
position, Vector3 lookTarget)
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o GameObject SpawnRailwayVehicle(GameObject railwayVehiclePrefab, List<Spline>
targetRails, float t)

11.5. Railroad Switches

e RailroadSwitch_v3 Properties
o bool Activated { get; }
List<GameObject> RailsColliders { get; set; }
List<Spline> RailsSplines { get; set; }
List<int> AffectedRoutes { get; set; }
UnityEvent OnActivate { get; set; }
UnityEvent OnDeactivate { get; set; }
o UnityEvent OnSwitch { get; set; }
e RailroadSwitch_v3 Methods
o void SwitchRails()
o void UpdateActivationStatus()
o void SwitchRailsBylndex(int[] indexes, bool activation)
o void SplineBasedSwitchRails(ILocomotive locomotive, int leftRoutelndex, int
rightRoutelndex)

O O O O O

11.6. Control Zones

e CustomEventZone Properties

o UnityEvent CustomEvents { get; set; }
e BellZone Properties

o ZoneTriggerType TriggerType { get; set; }
e ReverseDirectionZone Properties

o ReverseDirectionMode ReverseDirectionMode { get; set; }
e SpeedChangeZone Properties

o float TargetSpeed { get; set; }
e StationStopZone Properties

o StopMode StopMode { get; set; }
StationDoorDirection StationDoorDirection { get; set; }
StationBehaviour StationBehaviour { get; set; }
float StopTimeout { get; set; }
int RandomStopProbability { get; set; }

o bool TurnOffEngines { get; set; }
e SwitchTriggerZone Properties

o SwitchMode SwitchMode { get; set; }
int RandomSwitchProbability { get; set; }
List<RailroadSwitch_v3> RailroadSwitches { get; set; }
int LeftRoutelndex { get; set; }
int RightRoutelndex { get; set; }

O O O O

O O O O
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12. License

By purchasing this asset you are allowed to use it for unlimited games and/or 3D projects
(like animations, simulation softwares, etc). Both personal and commercial use.

You are NOT allowed to resell or distribute the assets components individually or as part of
another asset package (including, models, scripts, etc).

For more information about licensing, please refer to the Asset Store EULA and EULA FAQ.

13. Contact Info & Support

If you have any questions, need support or have some business inquiries, feel free to getin
touch.

Support requests are now being handled exclusively by email at
wsmgamestudio@gmail.com

Your request must contain the following information:

e Asset Store Invoice Number
e Unity editor version
e Detailed description of the issue (including screenshots if possible)

The best way to reach me is by email at wsmgamestudio@gmail.com

Asset Store Facebook
Discord Twitter

Sketchfab Youtube Channel
Instagram Artstation
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